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Safety
Before installing this product, read the Safety Information.
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Les sikkerhetsinformasjonen (Safety Information) for du installerer dette produktet.

Przed zainstalowaniem tego produktu, nalezy zapoznac¢ sig
z ksiazka "Informacje dotyczace bezpieczenstwa" (Safety Information).

Antes de instalar este produto, leia as Informagdes sobre Seguranca.
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Antes de instalar este producto, lea la informacién de seguridad.
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Chapter 1. Introducing the IBM PureFlex System offerings

IBM PureFlex System offerings are fully integrated systems that include compute,
storage, systems management, and networking components. The following IBM
PureFlex System offerings are available:

* Express

This offering is designed for small and medium businesses. See the IBM
PureFlex System Express overview at |http:/ /publib.boulder.ibm.com/ |
infocenter/flexsys/information /topic/com.ibm.acc.pureflex.doc//
p7een_expressoverview.html| for a more detailed description.

e Standard

This offering is optimized for application servers and comes with storage and
network devices that are designed to support key independent software vendors
(ISV) solutions. See the IBM PureFlex System Standard overview at

http:/ /publib.boulder.ibm.com/infocenter/ flexsys/information/ topic/|
com.ibm.acc.pureflex.doc/p7Zeen_standardoverview.htmll for a more detailed
description.

* Enterprise

This offering is optimized for scalable cloud deployments. It has built-in
redundancy for high-reliability and is designed to support critical applications
and cloud services. See the IBM PureFlex System Enterprise overview at
http:/ /publib.boulder.ibm.com /infocenter/flexsys/information / topic/|
com.ibm.acc.pureflex.doc/p7een_enterpriseoverview.html] for a more detailed
description.

More detailed information about the IBM PureFlex System offerings is available at
lhttp:/ /publib.boulder.ibm.com /infocenter/flexsys/information /index.jsp}

Important information about this document

This topic provides important information about the Supplemental Installation
Information document.

This Supplemental Installation Information document is intended only for use by IBM
Business Partners who plan to install IBM® PureFlex System offerings without the
assistance of IBM Lab Services. This guide assumes that the IBM Business Partner
has completed the IBM PureFlex courses listed below (or their equivalent) and is
familiar with the IBM PureFlex, IBM Flex System, and other documents listed in
“Related documentation” on page 2/

e IBM PureFlex System Fundamentals
NGT11 - classroom
NGV11 - online

The fundamentals class provides a comprehensive introduction to planning,
installing, configuring, and upgrading the IBM PureFlex offerings. It includes
hands-on lab exercises to reinforce the learning principles associated with the
Chassis Management Module, X-Architecture and Power Systems compute
nodes, IBM Flex System Manager, and networking.

e IBM PureFlex Systems Implementation Services
NGTB2 - classroom
NGVB?2 - online

© Copyright IBM Corp. 2012 1
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This hands-on course prepares IBM Business Partners to provide installation
services for IBM PureFlex Express and IBM PureFlex Standard offerings.

IBM Flex System Overview with Systems Management Focus
NGT40 - classroom
NGV40 online

This course will provide an overview of all IBM Flex System components and
focus on its systems management building blocks. Discussions include a review
of the Integrated Management Module (IMM) and Flexible Service Processor
(FSP), describe the Chassis Management Module (CMM), and explore the Flex
System Manager (FSM). The Flex System Manager hardware, software setup,
selected management tasks and navigation will be reviewed.

See |https: / /www-304.ibm.com /jct03001c/services/ learning/ites.wss/zz/ |

len?pageType=page&c=X120568090121W2(| for additional information about all of

the courses that are available.

Suggested tools

You might need to use one or more of the following tools during the installation:

USB key

USB hard disk drive

USB CD/DVD drive

Ethernet cable

Software (Windows Workstation)
Strawberry Perl Interpreter v5.12.3
WinSCP or Cygwin or PuTTY PSCP
Filezilla FTP Server

PuTTY

vSphere client

Related documentation

2

In addition to this Supplemental Information document, the following documentation
is available:

IBM PureFlex course material

— IBM PureFlex System Fundamentals student workbooks (from Course NGT11
or NGV11)

— IBM PureFlex Systems Implementation Services student workbooks (from
Course NGTB2 or NGVB2)

IBM PureFlex Information Center documentation

The IBM PureFlex Information Center provides information to help you plan for,
install, manage, and troubleshoot an IBM PureFlex configuration.

Go to |http:/ /publib.boulder.ibm.com /infocenter/ flexsys/information/ topic/| |
[com.ibm.acc.pureflex.doc/p7een_template_landing html[ to view or download
information from the IBM PureFlex Information Center.

IBM Flex System Information Center documentation

The IBM Flex System Information Center provides information about the many
IBM Flex System products, including the following:

— Quick Start guides

IBM PureFlex System: Supplemental Installation Information
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The Quick start guides are a collection of quick start task-oriented guides that
provide step-by-step instructions to help you set up and use your IBM Flex
Systems Enterprise Chassis, chassis components, and management devices
and interfaces. More than 70 Quick Start guides are provided to help with
installing, configuring, and managing the hardware, installing operating
systems, deploying virtual appliances, using the IBM Flex System Manager
software. Be sure to browse the collections to find information on additional
tasks you can perform using your IBM Flex System hardware.

IBM Flex System Enterprise Chassis Installation and Service Guide

This document contains information about setting up, configuring, and
troubleshooting the IBM Flex System Enterprise Chassis and its components.

IBM Flex System Chassis Management Module Command-Line Interface Reference
Guide

This document explains how to use the Chassis Management Module
command-line interface (CLI) to directly access management functions. The
command-line interface also provides access to the text-console command
prompt on each compute node through a Serial over LAN (SOL) connection.

IBM Flex System Chassis Management Module User’s Guide

This document explains how to use the Chassis Management Module user
interface to manage chassis components.

IBM Flex System Manager Systems Management Guide

This document explains how to use the IBM Flex System Manager user
interface to manage chassis components.

IBM Flex System Manager Commands Reference Guide

This document explains how to use commands to configure IBM Flex System
Manager and perform many other systems-management operations.

IBM Flex System Manager Network Control

This document describes an extension of the IBM Flex System Manager
product called IBM Flex System Manager Network Control, which can be
used to discover, inventory, and monitor network devices, launch vendor
applications for configuration of network devices, and view groups of
network devices.

IBM Flex System Manager VMCotrol

This document describes IBM Flex System Manager VMControl, which is can
be used to manage virtual servers, virtual appliances, workloads, and system
pools across multiple hardware platforms and virtualization environments
from one location.

IBM Flex System Compute Node documentation

Seperate doccumentation is available for each of the IBM POWER7®
Architecture-based and X-Architecture-based compute node. The
documentation includes information for installing, upgrading, configuring,
and troubleshooting each of the IBM Flex System compute nodes.

IBM Flex System V7000 Storage Node documentation

This documentation includes information for planning, installing, upgrading,
configuring, administering, monitoring,, and troubleshooting the IBM Flex
System V7000 Storage Node node .

IBM Flex System network device User’'s Guides

These documents contain detailed information about installing, configuring,
updating, and troubleshooting specific IBM Flex System network devices,
which include network switches, pass-thru modules, and adapters.

Chapter 1. Introducing the IBM PureFlex System offerings 3



Go to |http:/ /publib.boulder.ibm.com/infocenter /flexsys/information/topic /|

[com.ibm.acc.common.nav.doc/ic-homepage.html|to view or download

information from the IBM Flex System Information Center.
IBM Storwize® V7000 Information Center

The IBM Storwize V7000 Information Center contains all of the information that
is required to set up the Storwize V7000 hardware and to manage the system
using the web-based management GUI or the command-line interface

Go to |http:/ /pic.dhe.ibm.com/infocenter /storwize /ic/ topic/ |

[com.ibm storwize.v7000.doc/v7000_ichome_640.html|to view or download

information from the IBM Storwize V7000 Information Center.
IBM Redbooks

Many IBM Redbooks® are available for IBM PureFlex and IBM Flex System
products including the following;:

— IBM PureFlex System and IBM Flex System Products and Technology, SG24-7982
— IBM Flex System Interoperability Guide, REDP-FSIG

— IBM Flex System Enterprise Chassis, TIPS0863

— IBM Flex System Manager, TIPS0862

— IBM Flex System x240 Compute Node, TIPS0860

— IBM Flex System x220 Compute Node, TIPS0885

— IBM Flex System Interoperability Guide, REDP-FSIG

For a complete list of IBM Redbooks available for IBM PureFlex and IBM Flex
Systems products, go to [http: / / www.redbooks.ibm.com /portals/puresystems| .

Notices and statements

4

The caution and danger statements in the documentation are also in the
multilingual Safety Information document. Each statement is numbered for
reference to the corresponding statement in the Safety Information document.

The following notices and statements are used in this document:

Notes: These notices provide important tips, guidance, or advice.

Important: These notices provide information or advice that might help you
avoid inconvenient or problem situations.

Attention: These notices indicate possible damage to programs, devices, or data.
An attention notice is placed just before the instruction or situation in which
damage might occur.

Caution: These statements indicate situations that can be potentially hazardous
to you. A caution statement is placed just before the description of a potentially
hazardous procedure step or situation.

Danger: These statements indicate situations that can be potentially lethal or
hazardous to you. A danger statement is placed just before the description of a
potentially lethal or hazardous procedure step or situation.

IBM PureFlex System: Supplemental Installation Information
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Chapter 2. Installing the IBM PureFlex System offerings

Use the following procedure as a guide during the installation process.

Attention: The chassis components come with a preloaded configuration for the
IBM PureFlex System offering. Do not reset the chassis components to the factory
defaults. This will defeat the preloaded system configuration.

1.

© Copyright IBM Corp. 2012

Use the procedures in the Installing and configuring IBM PureFlex System
document (available at |http:/ /publib.boulder.ibm.com/infocenter/ flexsys/ |
information /topic/com.ibm.acc.pureflex.doc/p7eel_ex_pdf.pdf) to complete
the following steps; then, return to this Supplemental Information document to
configure the IBM PureFlex System.

* Remove the outriggers, position the rack, install the covers, and install the
stabilizer bracket.

¢ Remove the shipping brackets.
* Verify that the V7000 storage is cabled between racks, if required.
* Connect power cords.

* Connect a device that has browser access to the CMM and perform a
verification check.

Note: Do not cable the device directly to the CMM. Use the instructions
provided in the Installing and configuring IBM PureFlex System document to
cable the device.

If a green check mark is next to the System Status choice on the CMM menu,
continue with the next step. If any components are highlighted in yellow or
red, you must resolve the issue before you continue. To determine the
potential cause of the issue, click on the yellow or red highlighted component;
then, select the Events tab to view the log.

See [Chapter 3, “Configuring the network,” on page 9 to complete the
following steps:

a. If you have x86 compute nodes, review the x86 node configuration
information.

b. Review the V7000 storage subsystem configuration.

c. Configure the IP addresses.

Define the security settings through the IBM Flex System Manager

management software, including the security policies and password policies.

For more detailed information about security settings, see

http:/ /publib.boulder.ibm.com/infocenter /flexsys/information /topic/|

com.ibm.acc.8731.doc/security.html}

Validate the IPv6 addresses. See [Chapter 3, “Configuring the network,” on|

for instructions.

Configure the storage and storage pools. See [Chapter 4, “Configuring storage|
land storage pools,” on page 21|for instructions.

Configure the system management node. See [Chapter 5, “Configuring the IBMI
[Flex System Manager management node,” on page 47|for instructions.

Configure the virtual servers. See [Chapter 7, “Configuring virtual servers,” on|
for instructions.
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9.

10.

11.

12.

13.

14.

Install the operating systems. Instructions for using the IBM Flex System
Manager to deploy the operating systems are provided in the IBM Flex
System Information Center.

Important: If you are using VIOS or VMware with an Enterprise offering,
make sure that you consider your link aggregation configuration.

See Ihttp: / /publib.boulder.ibm.com/infocenter/flexsys/information/topic/ |
com.ibm.acc.8731.doc/deploying operating systems.html| and

http:/ /publib.boulder.ibm.com/infocenter/flexsys/information/topic/ |
com.ibm.acc.8731.doc/ hw_and_sw_requirements.htmll for instructions.

Create users and groups:

a. From the IBM Flex System Manager Home page, select the Additional
Setup tab; then, select Manage Users and Groups.

b. After you have created all of the user accounts, log out of the IBM Flex
System Manager web interface.

c. Log in to each new user account and when prompted, change the
password. (Record the new passwords.)

For more detailed information about users and groups, see
http:/ /publib.boulder.ibm.com/infocenter / flexsys /information/ topic /|
com.ibm.acc.8731.doc/managing_users_and_groups.html]

Configure the Electronic Service Agent (ESA):
a. From the IBM Flex System Manager Home page, select the Plug-ins tab.

b. Scroll to the bottom of the Plug-ins page; then, select Service and Support
manager.

C. Scroll to the bottom of the Service and Support Manager page; then, select
Getting Started with Electronic Service Agent.

d. On the Your company contact and System location pages, enter the
required information in the fields that are identified with an asterisk.

e. On the Connection page, select Connect to the Internet directly (the
default setting).

f. On the Authorize IBM IDs, enter the Primary IBM ID. (Make sure that you
register the email address (yours or your customer's) with IBM first.

g. On the Summary page, select Finish.

For more detailed information about ESA, see |http:/ /publib.boulder.ibm.com /|

infocenter/flexsys/information /topic/com.ibm.acc.8731.doc//

configuring_the_hw_and_sw.html|

Check the system status and make sure that there are no errors or warnings:

a. Locate the system status score card to the right of the Welcome banner on
the IBM Flex System Manager Home page.

b. If the score card indicates that there are active issues, select Problems to

determine which components have active issues; then, see

http:/ /publib.boulder.ibm.com/infocenter/flexsys/information/topic/ |

com.ibm.acc.common.nav.doc/|

diagnosing_a_problem_flex_system_manager.html| for additional
instructions.

If updates are available, run Update Manager. See |ﬂ71ttp:/ / |

publib.boulder.ibm.com/infocenter/flexsys/information/topic/ |
com.ibm.acc.8731.doc/updating_firmware_and_software.html for instructions.

If required, establish event automation plans. See |http:/ /|
[publib.boulder.ibm.com/infocenter /flexsys/information/topic/|
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15.

16.

com.ibm.director.automation.helps.doc/
[fqm0_t_ea_managing _automation_plans.html| for instructions.

Back up the IBM Flex System Manager software image to a local hard disk
drive or to an external USB device. See |http:/ /publib.boulder.ibm.com /|
infocenter /flexsys/information/topic/com.ibm.acc.8731.doc/|
backing_up_frm_summary.html| for instructions.

Back up your whole system to a USB device or remote secure FTP server. See
http:/ /publib.boulder.ibm.com/infocenter/flexsys/information/topic/ |
com.ibm.director.cli.helps.doc/ fqu_r_cli_backup.html?| for instructions.

Chapter 2. Installing the IBM PureFlex System offerings
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http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.8731.doc/backing_up_frm_summary.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.director.cli.helps.doc/fqm0_r_cli_backup.html?
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.director.cli.helps.doc/fqm0_r_cli_backup.html?
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Chapter 3. Configuring the network

Use the information and instructions in this chapter to verify and configure the
network IP address settings.

In this chapter, you will:
e Use the CMM to verify the correct IPv4 and IPv6 network IP addresses.
* Review and save the I/O module configurations.

* Review the compute node ESXi configuration, verify compute node network
communication, and create virtual machine port groups.

* Verify network communication with the storage subsystem.

* Verify network communication with the top-of-rack switches.

This chapter also includes a summary of IP addresses in [Table 1 on page 17

1. Obtain a list of the IP addresses that your client wants to use for the
installation.

2. Open a web browser and connect to the CMM. See [Table 1 on page 17 for the
default IP address information.

3. From the CMM menu, select Mgt Module Management » Network; then,
select the Ethernet tab and verify that the iPV4 and iPV6 settings match the
information provided in [Table 1 on page 17}

anagement = | Mgt Module Management ~ | | Search. . .
User Accounts Create and modify user accounts that will have access to this web con
Firmware View CMM firmware information and update firmware
Security Configure security protocols such as 551 and S5H
Network Network setfings such as SNMP and LDAP used by the CMM

© Copyright IBM Corp. 2012 9



Network Protocol Properties
o

Ethernet SHNMP DNS SMTP LDAP Client | TCP Command Mod:

Ethernet Configuration

Settings for how the Management Module communicates via Ethemsat

Host name MI‘-'I_SCFSFEEE E77F
Domain name
Register this interface with DNS

IPvg IPvE Advanced Ethernet

Currently assigned IPv4 address information
IP address: 10.1.110.90

Subnet mask;  255.255.255.0

Cefault gateway: 10.1.110.1

DMS primary: 0.0.0.0

DMS secondary: 0.0.0.0

DMS tertiary: 0.0.0.0

Configure IP address Settings: _
Use static IP addrgss |* |

4. From the CMM menu, select Chassis Management » Component IP
Configuration; then, hover the mouse over View in the IP Address column
and verify that the iPV4 and iPV6 settings match the information provided in
[Table 1 on page 17

ippori= | Chassis Managemenl~ | Mgt Module Management « Search

| Chassis Properfizs and sattngs for the overall chasse
Compute Nodes Properbes and settngs for compute node in the chassis
VO Modules Properties and settngs for /0 Modules in the chassis
Fans and Cooling Cooling devices instaled in your system

Power Modules and Management Fower dewces consumphion. and allecation

h.

I (= | Single locaficn for you o view and configura the various |P addness saiting of chassis components
=
Chassia Ink | Mt ¥ Prosires internal ronnectivte hetwaan raminiids nnda norts and the internal DU manansment nort
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Compute Nodes

Bay Device Name IPv4 Enabled IP Address

2 node02 Yes View

3 node03 Yes View

4 nodel4 Yes By 4

5 node0s Yes v IPvd Addresses

10.1.110.63

IPvE Addrezszes

fed0; SefifcffeSficdll

Note: If this is a new system from the factory and the IP addresses are not set
as per [Table 1 on page 17} contact IBM support.

* You can set the IP address of any listed device by clicking on the device
name. The IP Address Configuration window opens and displays the

Current IP Configuration for that device.

* To edit the IPv4 address, select the IPv4 tab. From this tab, you can edit the
address properties, IP Address, Subnet Mask, and Gateway Address; or,
you can change the configuration method to assign an address by DHCP.
Select Apply when you are done.

IP Address Configuration

node04

General Setting IPv4

IPvE

Current IP Configuration

MNetwork Interface
Configuration Method
IP Address

Subnet Mask
Gateway Address

Enable IPv4
Configuration Method

ethi

Use Static IP Address
10.1.110.64
255255255.0
10.1.110.1

¥
Use Static IP Address

New Static IP Configuration

IP Address
Subnet Mask
Gateway Address

| Apply |

| Close |

10.1.110.64
2552552550
1011101

5. From the CMM menu, select Chassis Management » I/O Modules.

Note: Depending on the hardware configuration that was ordered, you might
have more than one switch to review.

Chapter 3. Configuring the network
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Chassis Mana_gememv Mgt Module Management -

& System Status ~ Multi-Chassis Monitor  Evenls v Service and Support

Chassis Propeties and settings for the overall chassis

Compute Nodes Properties and settings for compute node in the chassis

LBS NGP  cnange

Service and Support no open problems.

System Information =

U0 Modules & Properties and settings for O Medules in the chassis I

Fans and Cooling Cooling devices installed in your system

6. Select the first I/O module; then, click the Actions tab.

=& /0 Modules

| Power and Restart = | | Actions = |

. Device Name | Restore Factory Defaults Bay Power | Serial Number
E_ié_r;.ﬂ_dé{:fé 1| SendPing Requests 1 On Y250V T15B298
I-l-C-)-l":"l-O-d-Lj-l-E-é"- Launch 1OM Conipgale I 2 On YO5OWT16EOQAL

12 Module 3 4 Normal 3 On Y¥K5022195007

7. Select Launch IOM Console, choose the protocol (https or SSH), and log in to
the switch.

Launch IOM Console

Interface IP: 101412

Protocol. HTTPS

If you selected the SSH protocol in step El go to step|10 on page 13| for
instructions.

If you selected the https protocol in step H, the Switch Dashboard is
displayed.

S e e e SRR I SRk

Switch Dashboard

Hrankh Farm FEEFERRITH

Bk Loculien Ig#lwua

S Tipa e vty BRA0RS G0 Sirtisd Fabews Srabaiin St
TSk Up Time 17 ficrs, 55 Beratn, 03 pnian w42 et
Emthema i3l b d e nelr |
i i1 [7Zanm, amrs

Tupmarncms Lovatian [ ]

[Pmlighe 2 Ties Siatan i__

e Ackdrmen (prE e

[ Petdrans [iiais

[P Fack Flnsoar. [T oL

(R Pan eaker  [SEAET

[RewManmer  [rooiisese

a. Click Dump under the dashboard.

Dashboard
Diff

ystem clock updated

Statistics

Networking OS

Logout

Configure

Help

Show Log

Revert Dump

Apply

Save
3350 NGP1BNTL NOT

A window is displayed that shows the current switch configuration.

12
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10.

11.

12.

b. From the web browser, select File » Save Page as. Name the file
showConfigDump.txt and change the file type to text files. The switch
configuration file has been saved.

c. Go to step
If you selected the SSH protocol, save the configuration to an FTP/TFTP

server using IBM NOS-CLL If prompted, select the preferred mode and use

the following procedure to save the switch configuration:

a. At the main prompt, enter the following command: cfg/ptcfg

b. When prompted, enter the IP address of the FTP/TFTP server, the name
the file, username, password, and the port to be used.

€. Once the connection is successful, the transfer will complete and you
should see a message similar to Current config successfully ftp'd to
9.44.68.148/tmp/config.txt.

Verify that you have collected all of the configuration output from all of the
switches within your configuration. Make sure that:

* The dump from each switch has a unique and logical name.

¢ Virtual local area networks (VLANS) are set correctly on the ports. See
[Table 1 on page 17] for more information.

* The spanning tree is set correctly.

e Trunks (aggregation groups) are set up correctly.

See also |http:/ /publib.boulder.ibm.com /infocenter/ flexsys/information /|
[topic/com.ibm.acc.networkdevices.doc/network.html| for more information
about the switches.

If you have x86 compute nodes with ESXi, follow the steps below to review
the x86 node configuration information. Make sure that you repeat this
procedure for all x86 compute nodes in your configuration.

of

Note: If your configuration includes Power nodes, the configuration of Power

nodes is reviewed in [Chapter 7, “Configuring virtual servers,” on page 63

a. Verify the ESXi configuration:

1) Using the information provided in [Table 1 on page 17} log in to an
ESXi remote console using the x86 nodes IMM.

2) Open a web browser, enter https://<IMM_address_of_ESXi>, and
provide the appropriate login credentials.

Chapter 3. Configuring the network
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Integrated Management Module

= U=er name:

= Password:

=t 4

E—_w Inactive ze=sion timeout:

Log In

Mote: To ensure security and avoid login conflicts, always
end your sessions using the "Log out” option in the upper
right area of the web page.

»Supported Browsers

3) After logging in, click Remote Control. Select your desired sessions
(Java Client, Single User Mode). If prompted to trust the certificate,
enter yes.

IBM Integrated Management Module Il

System Status Events »  Service and Support »  Server Manag

IBM Flex System x240+10Gb Fabric

Add System Descriptive Mame. , .

The Systemn Status and Health page provides an at-a-glence overview of the op

System Status
Power: On
System state:  Booting OS5 or in unsupported 05

| System Information = || Power Actions =

Active Events -

Severity & | Source Date Message
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Remote Control

Alows you to control the server at the operating system level. A new window wil appe;
Jisk and Remote Console functionalty. The Remote Disk functionality is bunched from ti
irop-down menu. (Mote that the Remote Disk function does not. .. more. . .

Guide for Remote Disk and Remote Console

@ Encrypt KVM data during remote controls is required to comply security level set
in CMM,

Use the ActiveX Client
o Use the Java Client

@ Your current browszer Java version (1.6.0.0) is supported for use with remote control.

Encrypt disk and KVM data during transmission

Start remote control in single-user mode |

Gives you exdusive access during the remote session, Mo other users will be able to use
remote control on this system while your remote session is active.

Start remote control in multi-user mode |
Allows other users to start remote sessions while your session is active.

4) Using a remote or direct console, connect to the ESXi host. Select F2
and log in using root/PasswOrd. Verify all network settings for the
ESXi hosts using the information provided in [Table 1 on page 17

Verify network communication:

1) You should be able to connect to EXT5 in the 10 Gb network switch
using a 1 Gb SFP module. If your notebook computer is on the same
subnet, you should be able to ping the ESXi host. You can also perform
a network ping from the ESXi host to your notebook computer and to
other components in the chassis.

2) If the pings are not successful, reverify the 10 GbE switch and ESXi
host configurations.

Configure virtual machine port groups:

Note: You must have vSphere client on your notebook computer to
perform this operation. If you do not have vSphere client, you can
download a copy at http://www.vmware.com/}

1) Using vSphere client on your notebook computer, connect directly to
your ESXi host using the information provided in [Table 1 on page 17 If
you receive a security warning, select Ignore.
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2)

3)

tall vSphe

r |
ent and | (%) VMware vSphere Client e

— Certificate Warnings

An untrusted S5 certificate is installed on ™10, 1, 110.33" and secure communication cannot be
guaranteed. Depending on your security policy, this issue might not represent a security concern,
You may need to install a trusted 55L certificate on your server to prevent this warning from

appearing.
The certificate received from "10.1. 110, 33" was issued for ocalhost. xlsgate2. xlslab®™ Secure

communication with "10.1,110.33" cannot be guaranteed. Ensure that the fully-qualified domain
name on the certificate matches the address of the server you are trying to connect to.

Click Ignore to continue using the current 551 certificate,

| View Certificate I Ianore I

[~ Install this certificate and do not display any security warnings for "10.1,110.33",

Cancel

=Sl r. Get sal
4} Connecting... Login | Cancel | Help | mentatior
ions, and

Caccinne and Wahinare

Select the Configuration tab, then Networking, and then click
vSwitchO Properties.

[T e Ty Local Users & Groups

Getting Started | Summary !'Virtual Machines - Resource Allocation | Performance

Hardware View: |vSphere Standard Switch
Health Status MErwkany :
Pracessors
?\ Viemory Standard Switch: vSwitchd Remave...
it Virnsal Machine Port Group Pryscal Adapzers
o viang Q. ES vmnicd 10000 Full [
torage Adapters (B |8 virtual machine{s) | VLAN ID: 4
Metwork Adapters vCenter 5.0 &
Advanced Settings FTP-SLES11 &

Power Management IBM SmartCloud Entry 2.3 {SLES11) @

By default, you will see one VMkernel Port Group and one Virtual
Machine Port Group. For the purple network (VLAN 4091) it will use
the default Virtual Machine Port Group. For the green network
(customer data on VLAN 4092), you must create a new Virtual
Machine Port Group. Select Add and the Add Network wizard will
initialize. Select Virtual Machine.

Connection Type
Metworking hardware can be partitioned to accommodate each service that requires connectivity.

Connection Type

Connection Settings Connection Types

Summary i e

Add a labeled network to handle virtual machine network traffic.

© VMkernel

The YMkernel TCP/IP stack handles traffic for the following ESXi services: vSphere vMotion, iSCSI, NFS,
and host management.

4) Under Port Group Properties, enter Customer Data 4092 for the

16

Network Label and enter 4092 for the VLAN ID. Click Next; then,
review your changes and click Finish. You will return to the vSwitch0
Properties window. Make sure that you see the new Virtual Machine
Port Group and click Close.
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—Port Group Properties

Metwork Label; !Cusmmer Data 4092|

VLAN ID (Optional):

4082

=)

13. Review the V7000 storage subsystem configuration:

a. Using the information provided in|Table 1, open a command prompt and
verify that you can ping the V7000.

b. If you cannot ping or connect to the V7000, connect your notebook
computer to the V7000 management port. Provide your notebook
computer with the same IP schema and attempt to connect. If this fails, try
to connect using the default IP address of the V7000 or use the serial port
to connect.

Note: If this is a new system and you cannot ping the V7000 at the default IP
address in|Table 1} contact IBM Support.

14. If top-of-rack storage area network (SAN) switches are included in your
configuration, review these switches.

a. Using the information provided in|Table 1, open a command prompt and
verify that you can ping the top-of-rack SAN switches.

b. If you cannot ping or connect to the top-of-rack SAN switches, connect
your notebook computer to the switch management port. Provide your
notebook computer with the same IP schema and attempt to connect. If
this fails, try to connect using the default IP address of the switch or use
the serial port to connect.

15. Return to [Chapter 2, “Installing the IBM PureFlex System offerings,” on page]

El and continue with step [4 on page 5

IP address summary

Note: Gateway and DNS must be provided by the customer.

Table 1. IP summary for express, standard, and enterprise configurations as shipped

Chassis

Bay Component IPv4 IPv6 prefix VLAN |Username |Password

Express

CMM 1 CMM #1 192.168.93.100 £d8c:215d:178e:c0de | 4093 USERID PasswOrd

CMM 2 CMM #2 192.168.93.100 fd8c:215d:178e:c0de |4093 USERID PasswOrd

I/Obay 1 |10 Gb Ethernet Switch |192.168.93.120 £d8c:215d:178e:c0de | 4093 USERID PASSWORD

I/O bay 3 |8 Gb Fibre Channel 192.168.93.122 fd8c:215d:178e:c0de | 4093 USERID PASSWORD
Switch

FSM (bay |ethO n/a fd8c:215d:178e:c0de | 4093 USERID PasswOrd

D ethl 10.91.0.2 £d8c:215d:178e:c0de |4091 USERID PasswOrd

Compute |FSP/IMM 192.168.93.150 fd8c:215d:178e:c0de | 4093 Same as CMM

;)Ode 1 ®ay [y10s/Esxi 109142 n/a 4091 |root PasswOrd
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Table 1. IP summary for express, standard, and enterprise configurations as shipped (continued)

Chassis

Bay Component IPv4 IPv6 prefix VLAN |Username |Password

V7000 Canister #1 192.168.93.210 fd8c:215d:178e:c0de |4093 superuser |PasswOrd
Canister #2 192.168.93.211 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd
Cluster #1 192.168.93.213 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd
Cluster #2 192.168.93.220 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd

Standard

CMM 1 CMM #1 192.168.93.100 fd8c:215d:178e:c0de | 4093 USERID PasswOrd

CMM 2 CMM #2 192.168.93.100 fd8c:215d:178e:c0de | 4093 USERID PasswOrd

I/Obay 1 |10 Gb Ethernet Switch |192.168.93.120 fd8c:215d:178e:c0de | 4093 USERID PASSWORD

I/O bay 3 |8 Gb Fibre Channel 192.168.93.122 fd8c:215d:178e:c0de | 4093 USERID | PASSWORD
Switch

I/O bay 4 |8 Gb Fibre Channel 192.168.93.124 fd8c:215d:178e:c0de | 4093 USERID PASSWORD
Switch

FSM (bay |ethO n/a fd8c:215d:178e:c0de |4093 USERID | PasswOrd

D ethl 10.91.0.2 fd8c:215d:178e:c0de |4091 USERID PasswOrd

Compute |FSP/IMM 192.168.93.150 £d8c:215d:178e:c0de | 4093 Same as CMM

Z‘)Ode 1 ®ay [y10s,/ESXi 10.91.4.2 n/a 4091 root PasswOrd

Compute |FSP/IMM 192.168.93.151 £d8¢:215d:178e:c0de | 4093 Same as CMM

g‘)"de 2 (bay [y10s/Esxi 10.91.8.2 n/a 4091 root PasswOrd

V7000 Canister #1 192.168.93.210 fd8c:215d:178e:c0de |4093 superuser |PasswOrd
Canister #2 192.168.93.211 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd
Cluster #1 192.168.93.213 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd
Cluster #2 192.168.93.220 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd

Enterprise (x86 only)

CMM 1 CMM #1 192.168.93.100 fd8c:215d:178e:c0de | 4093 USERID PasswOrd

CMM 2 CMM #2 192.168.93.100 £d8c:215d:178e:c0de |4093 USERID  |PasswOrd

I/Obay 1 |10 Gb Ethernet Switch |192.168.93.120 fd8c:215d:178e:c0de | 4093 USERID PASSWORD

I/O bay 2 |10 Gb Ethernet Switch |192.168.93.121 fd8c:215d:178e:c0de |4093 USERID PASSWORD

I/O bay 3 |8 Gb Fibre Channel 192.168.93.122 fd8c:215d:178e:c0de |4093 USERID PASSWORD
Switch

I/O bay 4 |8 Gb Fibre Channel 192.168.93.124 £d8c:215d:178e:c0de | 4093 USERID  |PASSWORD
Switch

FSM (bay |ethO n/a fd8c:215d:178e:c0de |4093 USERID | PasswOrd

D ethl 10.91.0.2 fd8c:215d:178e:c0de | 4091 USERID PasswOrd

Compute |IMM 192.168.93.150 fd8c:215d:178e:c0de |4093 Same as CMM

;)Ode 1 (bay [pexi 10.91.4.2 n/a 4091 root PasswOrd

Compute |IMM 192.168.93.151 fd8c:215d:178e:c0de |4093 Same as CMM

r3‘)°de 2 (bay g 10.91.8.2 n/a 4091 root PasswOrd
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Table 1. IP summary for express, standard, and enterprise configurations as shipped (continued)

Chassis

Bay Component IPv4 IPv6 prefix VLAN |Username |Password

V7000 Canister #1 192.168.93.210 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd
Canister #2 192.168.93.211 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd
Cluster #1 192.168.93.213 fd8c:215d:178e:c0de |4093 superuser |PasswOrd
Cluster #2 192.168.93.220 fd8c:215d:178e:c0de | 4093 superuser |PasswOrd

Enterprise (Power only)

CMM 1 CMM #1 192.168.93.100 £d8c:215d:178e:c0de |4093 USERID  |PasswOrd

CMM 2 CMM #2 192.168.93.100 fd8c:215d:178e:c0de | 4093 USERID PasswOrd

I/Obay 1 |10 Gb Ethernet Switch |192.168.93.120 £d8c:215d:178e:c0de |4093 USERID  |PASSWORD

I/O bay 2 |10 Gb Ethernet Switch |192.168.93.121 fd8c:215d:178e:c0de | 4093 USERID  |PASSWORD

I/0O bay 3 |8 Gb FC Switch 192.168.93.122 £d8¢:215d:178e:c0de |4093 USERID  |PASSWORD

I/O bay 4 |8 Gb FC Switch 192.168.93.124 fd8c:215d:178e:c0de | 4093 USERID  |PASSWORD

FSM (bay |ethO n/a fd8c:215d:178e:c0de |4093 USERID  |PasswOrd

) ethl 10.91.0.2 fd8c:215d:178e:c0de |4091 USERID  |PasswOrd

Compute |FSP 192.168.93.150 £d8c:215d:178e:c0de |4093 Same as CMM

node 1 VIOS 1091.4.2 n/a 4091 root PasswO0rd

(bays 3 - 4)

Compute | FSP 192.168.93.151 £d8c:215d:178e:c0de | 4093 Same as CMM

node 2 VIOS 10.91.8.2 n/a 4091 root PasswO0rd

(bays 5 - 6)

V7000 Canister #1 192.168.93.210 fd8c:215d:178e:c0de |4093 superuser |PasswOrd
Canister #2 192.168.93.211 fd8c:215d:178e:c0de |4093 superuser |PasswOrd
Cluster #1 192.168.93.213 £d8c:215d:178e:c0de | 4093 superuser |PasswOrd
Cluster #2 192.168.93.220 fd8c:215d:178e:cOde | 4093 superuser |PasswOrd

TOR Ethl |Management 192.168.91.221 £d8c:215d:178e:c0d | 4093 USERID PasswOrd

TOR Eth2 | Management 192.168.91.221 fd8c:215d:178e:c0d | 4093 USERID PasswOrd

TOR SAN1 |Management 192.168.91.222 £d8c:215d:178e:c0d | 4093 USERID PasswOrd

TOR SAN2 | Management 192.168.91.223 fd8c:215d:178e:c0d | 4093 USERID PasswOrd
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Chapter 4. Configuring storage and storage pools

Use the information and instructions in this chapter to configure storage and
storage pools.

In this chapter, you will:
* Review the Fiber Channel SAN switch configuration.
* Configure the storage subsystem.

* Verify storage pools, volumes, and host mappings.
Review the Fiber Channel SAN switch configuration

Each chassis contains either one or two QLogic fiber channel SAN switches. The

Enterprise offerings with Power compute nodes also include a pair of top-of-rack
IBM 2498B24 SAN switches. The top-of-rack switches are optional in the Express

and Standard offerings.

 If a top-of-rack SAN switch is not present, the QLogic FC SAN switches are
configured from the factory for full-fabric mode.

* If a top-of-rack switch is present in the configuration, the QLogic SAN switches
are configured for transparent mode and the Brocade top-of-rack switch is
configured in the full-fabric mode.

Note: The switches come pre-configured from the IBM factory. Do not alter the

zoning configuration in the switches.

1. Log in to each SAN switch from a web browser using:
https://<IP_Address_of_SAN_Switch>

The IP address of the switch will either be the pre-configured default value
from [Table 1 on page 17, or the customer's desired IP address that you might
have set in [Chapter 3, “Configuring the network,” on page 9

2. For the QLogic switches, verify that the switch mode is appropriate for your
configuration. You can determine the switch mode by examining the initial user
interface.

* If the Zoning command appears on the menu bar, the switch is in full-fabric
mode.

¢ If the Zoning command does not appear on the menu bar, the switch is in
transparent mode.

3. If the QLogic switch is in transparent mode, verify that the internal ports (ports
mapped to the compute nodes) are mapped to the correct external ports.

Note: The Enterprise with Power node offering requires four ports to be
connected between the QLogic chassis switch and the Brocade top-of-rack
switch. Best practice is to balance the mapping of the nodes internal ports to
the external ports, if possible. For example, if there are four nodes in the
chassis, map each node's internal port separately to each external port. If there
are 13 nodes in the chassis, then map three or four node's internal ports to each
external port.
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Eile Switch Port View Help

>
= I 1BMEGH
e
Z Field |IEMBGH
Switch Type IBM Flex Systern FC3171 8Gb SAN Switch
First Port Address MIA - does nat apply to this switch
i World Wide Mame 10:00:00:c0:dd: 170411
A erial Mumber 11880 3582KE0221 BENOZ
ey Reason for Status Marrmal =
‘Bndor (=10
% MAC Address 00:c:dd1thd:11
= itch UUID 4EC1AZYABCABBCFFOFZFO0CODDTFE412
@) CPLD Revision Ox410101,0620
Megotiated Domain (D MiA - does nat apply ta this switch
g:‘.ﬁ Canfigured Domain 1D MiA - does nat apply to this switch
Dormain ID Lock MNits - does not apply fo this switch
Primary CPU MiA - does not apply to this switch
ernndan CPLL St MiA - dnes it anok to this switch
| Switch | FCPort Stats | portinfo |

a. Review the port mapping using the Port » Map Ports menu command.
Internal ports are listed along the left side of the screen and the external
ports are listed across the top. For each possible mapping, the choices are:

¢ No mapping
e Primary
* Backup

Note: Ports designated as Backup only become active when all primary
ports fail.
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Map Porks
TF Ports

Ext 1:0 Ext 2:15 Ext 3:16 Ext £:17 Ext 5:18 Ext 6:19

___HnE el Eul EnE a.n

Bay 1

Bay 2
Bay 3

Bay 4

Bay 5

I S
I i S
eava - pacn [~| NI N T I IR
ey (oo || I (I S I
ey 10 BRI [jl----

Bay 6

Bay 7
THPorts

Bay 11 |Ba:

Bay 12

| oK H Cancel H Help ‘

b. Verify that each internal compute node port is correctly mapped to an
external port and that at least one backup external port is designated for
each internal node port.

4. Verify that there is one SAN zone for each compute node host port on each
SAN switch. Each zone should include the compute node host port and all of
the storage subsystem host ports. Zones should be labeled so that they are
easily identifiable, slot_2 for example.

* On a QLogic switch, select Zoning » Edit Zoning to view the Edit Zoning
worksheet. Verify that at least one zone exists for each primary compute
node host port for each full-fabric SAN switch.
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B cdit Zoning I

File Edit

@ &
Zone Set  Jone Alias Insert  Remove Copy Paste

Sets: 1/256; Zones: 4 / 2000; Members: 30 / 10000; Zones in Sets: 4 /2000; Aliases: 6 / 2500
¢ Zone Sets 2
ZoneSet: ORPHAN ZONE SET

9 ZoneSet CTBY3-924-Zone-Set-A
-3 E| Zone: PTE95-225-Y05-3-Zone-A
o= |:| Alias: P7895-22-VI0S5-3
e |:| Alias: V7000-0COEAFC-C1P1
o |:| Alias: V7000-0COEAFC-C2P2
s E| Zone: PTE95-4 24-VI05-1-Zone-A
o |:| Alias: PTE9S-4 2501051
e |:| Alias: V7000-0COEAFC-C1P1
o |:| Alias: V7000-0COEAFC-C2P2
s El Zone: XBY3T-AC1-ESK-1-Zone-A
o= |:| Alias VTO00-0C0EAFC-C1P1
e |:| Alias: V7000-0COEAFC-C2P2
o |:| Alias: K87 37-AC1-ESHA
L's E| Zone: XBT737-AC1-ESK-2-Zone-A
; o= |:| Alias: V7000-0COEAFC-C1P1
. o |:| Alias: VFOO00-0COEAFC-C2P2

SMembers
i ¢ = LBSAUSNGP1BN3
o ¥ Domain:t Ext1:0
¢ [] Foaddress n10000
|

R B00050T 68011075 7e (IEM 2145 (Rev, 00007
Diormnain:t Bay 1
? Domain:d Bay 2
T Ij FC Address: 010200
E AR 21:00:000 242165 d4 (Glogic Corporation)
|8 Dormain:! Bay 3
%l Comain:t Bay 4
Hl Damain:t Bay 5
Diomain: Bay 6
Domaind Bay 7
Darnain: Bay 8
Domain:d Bay 9
Domain:d Bay 10
Domain:d Bay 11
Domain:d Bay 12
Hl Damain:t Bay 13
= Hl Damain:t Bay 14
8| Domain:t Ext2:15
¢ [ Feaddress n10mo
2 E W B0:05:07:68:01:20:7che (BM - 2145 (Rey. 00007
o |:| Alias: KBT37-AC1-ESX-2 Dormain: Ext 216

Alias: P78Y5-22X-VI05-3 Darnain: Ext 417
Domain:t Ext 518

Domain:t Ex 619

Alias: P7E95-42044105-1
Alias: ¥T000-0COEAFC-C1P1 ]

T T

| s e e =

Aligs: WrO00-0COEAF C-C2P2

4|

| Apphy || Close || Help |

¢ On a Brocade switch, click Zone Admin on the Web Tools screen.

IBM_2498_B24_SAN1 - Web Tools

Manage Reportz  Monitor  Tools

Al

I
AP OS‘tatusil DTempi OPDWEI’| QO

Tasks

Manage

i i i -
@ e g Admin Domain ADO |

! Switch Admin | Switch Yiew

[ port Admin

EE Admin Domain

G} Fabric Watch

Monitor

Swvitch Everts, Information

[7] Hame Server | | Switch Everts | Switch Information |

[ Performance

On the Zone Administration screen, select the Zone tab. Click the
drop-down button for the Name box. Verify that at least one zone exists for
each primary compute node for each full-fabric SAN switch.
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File Fabric Switch Port
- o377.164

A IBM_2498 BZ4 SAN1 - Fone Administration

q

Zoning Modes b Basic fones
BigiPhnes Print  Edit Wiew Zoning Actions
Traffic Izolation Zones Mesw: ™ Resource Yiew ™ "{:'Q::« Refresh = Er:

|/Alias I Zone |=-__' Zone Config |
| | Mame |DS4500%M_x5_x9 -| Hlew zc
DS4B00VM_X8_X9 E
DS4800_ISYTHE il
SDS4500_MGMT
[Eo=ds00_xE
EFs1_ssansot
IFS1_3690Tap
IFS1_IFs2
IFS1_NGPIET2

__.r-.ﬂemb

q|

5. Verify the zone set configuration.

Note: A Zone Set (QLogic) or Zone Config (Brocade) contains one or more

zones defined on the SAN switch. Only one Zone Set or Zone Config can be
active at a time on a SAN switch.

* On a QLogic switch, return to the main screen and click the Active Zoneset
tab. Verify that all of the required zones are included in the active Zone Set.

Zoning View Wizards Help

| BSAUSNGR15WE |

Bay

LESALSHNGR1SWS
o

ZoneSet C7RY3-92¥-7one-Set-A
El Zone: PTE9S-224-VI08-3-Zone-A
o= E| Zone: PTE95-42:-VI08-1-Zone-A
o EI Fone: XY 37-AC1-ESH-1-Zone-A
o= EI Zone: XBT3T-ACT-ESX-2-Fone-A

| Switch | FCPort Stats | Portinfo | Configured Zonesets | Active Zoneset |

On a Brocade switch, click Zone Admin on the Web Tools screen; then, click
the Zone Config tab. Note the name of the Effective Zone Config (lower
right corner) and make sure that this Zone Config is selected in the Name
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box. Verify that all of the defined zones are present in the Zone Config
Members box for each full-fabric SAN switch.

: Basic fones

_zcu_ning Modgs

. Print  Edcit iew Foning Actions
Basic Zones

Traffic Isolation Zones Mew ™ Reszource Yiew ™ ‘?cp Refresh = Enakbile Config Save Config Clear All
| finiies, | El:mel Fane Confi I
: : | ' ' |
o -mer_SAN_}_\. ".| Mewe Zone Config | Delete | Repame | Clone |
Member Selection List \4 Fone Cu:unfig_ Members
= Zones (1189 Zones) T 108 Zones. o
W D34a000 0 x5 xaid Mel B s%] DS45800_ISVTHE -
W DSL500 ISIFREE Merni 2% DS4800_MGHMT @
of DSL500 MGMTYE Mepni sb| DS4800_X6
o| 054500 B Members) %) DS4a00YM_Xa_K3
o F=1 _3690Bct
# [FS1 _3690Top
------------------ of IFS1 _IF=2
# FS1_P12
of F=1_P13
o [FS1 _%10_1
of FS1_W10_3 =
o IFS1 _%11 1 | =4
[ Current Yiew:  Fabric View & Effective Zone Config: SAN_.I'@.
B |

e

6. Back up the configuration of each full-fabric SAN switch after the configuration
has been verified.

* On a QLogic switch, select Switch » Archive from the menu. Enter a name
for the .xml file and save it.

* On a Brocade switch, click Switch Admin from the Web Tools screen; then,
click the Advanced Mode button. Select the Configure tab; then, select the
Upload/Download tab in the lower bar. Click the Config Upload button.

Note: You can transfer the switch configuration file to the IBM Flex System
Manager using SCP. Otherwise, you might need to have an FIP server or
SCP server on your workstation to facilitate the transfer. If you are using an
FTP server or SCP server on your workstation, make sure that your firewall
does not block the transfer.

Enter the Host Name or IP, User Name, Password, Protocol Type and a
Configuration File Name; then, click Apply.
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IBM_2498_B24_SANT - Switch Administration _ O] ]
* Showe Basic Mode |
7 I
‘ SwwitchMame: IBM_f_BM_SANT DomainlC: 400:47 WA 10:00:00:05:55:29:31:66 Fri &pr 132012 16:24:39 MSTi
SHMP- r Configure T Rating r Extended Fakbric |' AL Service I/'Tra_c:e' |/ FICOM CUP rse.curwppucues |
Switch r Metwwark | Firmrereare Dovwenload ]V License | Ll=er |/ Trunking

Function

@ Config Upload () Config Download to Switch

Select source of configueation file: (@ network () LUSB

Provide Host details, Transfer Protocol and Path for Configuration file
*Pazzword iz optional, if uzer name iz "anonymous"

Host hame or IP |9.11 83147 |
User Name [UzERID |
Pazzward | LIITIT T |
Protocol Type Secure Copy Pratocol (SCF) A |

Configuration File Mame |SAN?_config

UploadDownioad Progress: | |

[ Fabric | virtuslGhannel | arbtrated Loop | System | interopershiity | Firmware | UplosdDawnioad |

[Switch Administration opened]: Fri Apr 13 2012 16:1239 MET
[upload started]: Fri Apr 13 2012 16:15:39 MST

Initisting configuration file [SAMNT _config] upload to 911 83147
Configlpload completed successiully.

[upload completed): Fri &pr 13 2012 16:15:39 MST

upload completed successiully, | Mode; Advanced | Free Professzional Marsgement Tool | 9.11.82.24 | ADO | User; admin | Role: admin |«

7. Continue with|“Configure the storage subsystem.”|

Configure the storage subsystem

1. Log in to the V7000 storage subsystem from a web browser using
https://<IP Address_of_V7000>. Use the pre-configured IP address found in
[Table 1 on page 17
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“}Login - IBM Storwize ¥7000 - Mozilla Firefox

Fle Edt ‘iew Hstory Boockmarks Tocks  Help

oy o |
ek - G X 4 hitps:)/10.10.0,215/ v |{'..,"|G00gle P
2 Most Visited | T8ML (72 BlusPages | | ISYAMZ-IMM || ISVXS-IMM | | IS¥X4-IMM || ISVRS-IMM || ISYS6-IMM | | ISWXA-IMM || ISVXG-IMM »

OORR | 1 | nodel - | || Login - IBM Storwize ¥7000

IBM® Storwize® V7000

Enter the superuser password:

[enseenes]

Welcome

Welcome to IBM Storwize w7000 system. This wizard guides you through the initial
configuration,

Learn More L

b wisit the Information Center

@ view an e-Learning overvieuw

License Material - Property of IBM I::c._r|:|:@J IBM Corporation and other(s) 2010, IBM and Storwize are registered _‘E(J LI
| Done: EA

2. Accept the license agreement and click Next.
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£7) IBM Storwize ¥7000 - Mozilla Firefox

Eilz

Edit “iew History Bookmarks Tools  Help

S

hitps:j/10.10.0.215/E25etup - |28 = Gongee

2 Most Yisited IEM1 i*; BluePages | ISYAMZ-IMM | ISWH3-IMM | ISWe4-IMM | ISWRS-IMM | ISWHe-IMM | ISYSP-IMM | ISWHE-IMM

| | 78G00RR. | 1 | nodel - Home - IBM Stor ... =

| '} 1BM Storwize ¥7000 x [ +]

License Agreement (Step 1 of 6)

Read the license agreement carefully.

License IBM Notices Java MNotices Non-IBM Licenses Additional Licenses and MNotices
International Program License Agresment ﬂ
Part 1 - General Terms

BY DOWNLOADING, INSTALLING, COPYIMG, ACCESSING, CLICEING ON AN "ACCEPT" BUTTON, OR OTHEEWISE USING THE
PROGEAM, LICENZEE AGREEZS TO THE TERMS OF THIS AGREEMENT. IF YOU ARE ACCEPTING THESE TEEMS ON EEHALF OF
LICEN2EE, T0U REPRESENT AND WAREANT THAT TOU HAVE FULL AUTHORITY TO EIND LICEN2EE TO THESE TEEME. TIF
YOO L0 NOT ALGREE TO THESE TERME,

- DO WNOT DOWNLOAD, INSTALL, COPY, ACCESS, CLICE ON AN "ACCEFT" BUTTON, OF USE THE PROGEAM; AND

- PROMPTLY RETURN THE UNUSED MEDIA, DOCUMENTATION, AND PROOF OF ENTITLEMENT TO THE DPARTY FROM WHOM IT
WAS OBETAINED* FOR &4 REFUND OF THE AMOUNT PAIDR. IF THE PROGERAM WAS DOWNLOADED, DESTROY ALL COPIES OF THE
PROGEAM.

1. Definitions

"Authorized Use" - the specified lewel at which Licensee is authorized to execute or run the Program.
That level may be measured by nuwber of users, millions of service units ("M8Us"), Processor Value

Tnics ("PVU="), or other lewel of use specified by IEM.

"IBM" - International Business Machines Corporation or one of its subsidiaries. vi

w1 agree with the termis in the license agreement.

(I do not agree with the terms in the license agreement.

Mext = |

[ane

2 4

3. Enter a System Name, select a Time Zone, and set the Date and Time.
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£7%) IBM Storwize ¥7000 - Mozilla Firefox

File Edit iew History Bookmarks Tools  Help

& -cxo

5| httpssff10,10.0,215/EZSetup

vir B I-'.lV!GoogIe p=l

2 Most isited | 1BM1 [7E BlusPagss | | ISYAMZ-IMM | | ISWNS-IMM | | ISYX4-IMB | | ISVRS-TMM | | ISYR6-IMM || ISWXF-IMAM | | ISWRE-IMM »

| | | 78G00RR. | 1 | nodel - Home - IBM Stor... = | .| IBM Storwize ¥7000

s

Name, Date, and Time (Step 2 of 6)

System Name

ISW7KG 1

Time Zone

(GMT-7:00) US Mountain Time| | ]

(8) Set Date and Time

Setto V7000_1 or other name of customer's
choice.

Date | 4/28/2011

(@)12-Hour () 24-Hour
Time

|2:52 [ Pm | =]

() Set NTP Server IP Address

| Hext > |

Dane

—E

4. Click Set NTP Server IP Address, if one is available, enter the IP address, and
click Next. Task completion details are displayed. Review the data you entered

and click Close.

Note: The IBM Flex System Manager is a good choice for an NTP server. You
should enter the IPv6 address of the IBM Flex System Manager ethQ interface
for the NTP server. If this IP address is unknown, the NTP server can be set
outside of the initial setup wizard (Settings » General » Date and Time).
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E% 1BM Storwize ¥7000 - Mozilla Firefox

File  Edit iew History Bookmarks Tools  Help

W (&= 7r https://10,10.0,215/EZ5etup i |-'.]v|Gaogle P
2 MostVisited | 18M1 [7Z BlusPages | | ISWRMZ-IMM | | ISVKS-IMM | | ISVR4-IMM | ISWRS-TMM || ISWRE-IMM | | ISWRP-IMM | ISWRE-IMM »
| | 78G00RR. | 1 | nodel - Home - IBM Stor ... = | || 1BM Storwize ¥7000 * | = F

Name, Date, and Time (Step 2 of 6)

System Name

: ISV7KB |

Time Zone

| {GMT-7:00) US Mountain Time

| 4|

() Set Date and Time

(@) Set NTP Server IP Address

Set the IP Address of a known NTP server if
711.107.11 < | available.

| -Next = ";

Dane ﬁ A

5. If the customer has purchased licenses to manage external storage, enter that
information on the System License screen and click Next. If the customer has
not purchased additional licenses, leave the values set to zero and click Next.
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£ IBM Storwize ¥7000 - Mozilla Firefox

File Edit Wiew History Bookmarks Tools  Help

Q@ - c o [

hitps: /{10, 10,0, 21 5{EZ5etup vz | |28 cooge »

2 Most isited | IBM1 [7Z BlusPagss | | ISYAMZ-IMM | ISWNS-IMM || ISYX4-IMB | | ISYRS-TMM | | ISYRG-IMM || ISWXF-IMAM || ISWRE-IMM

| || 78G00RR. | 1 | nodel - Home - IBM Stor... = | || IBM Storwize ¥7000 * | -

System License (Step 3 of 6)

The enclosure license already includes virtualization of internal Serial aAttached
SCSI(5A5) drives on your IBM Storwize w7000 system, You can use this panel
to set any additional options. If you are sharing the total authorized capacities
across multinle clusters, enter only the capacities you wish to use on this

cluster. The sum of the capacities across all clusters must not exceed your
authorized capacities,

Set License Options
External Virtualization Lirnit

Murnber of enclosures

Remote-Copy Limit

Murnber of enclosures

| Mext > |

Read 10.10.0,215

32

6. Click Next to bypass the Configure Email Event Notification screen.

Note: Do not configure email event notification from the V7000 storage

subsystem for PureFlex systems. Event notification is handled by the IBM Flex
System Manager.
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&% 1BM Storwize ¥7000 - Mozilla Firefox

File  Edit iew History Bookmarks Tools  Help

g - C 42 | SRRt https://10.10.0.215/E25etup 77 - |28 cooge r
2 Mostvisited | 18M1 [7E BlusPages | | ISVWMZ-IMM | | ISYA3-IMM | | ISVXA-IMM | | ISWNS-IMM | | ISYR6-IMM | | ISWRP-IMM | | ISvaE-IMM »

| | 78G00RR. | 1 | nodel - Home - IBM Stor ... = | | 1BM Storwize ¥7000 x | -

Configure Email Event Notification (Step 4 of 6)

To ensure your system continues to run smoothly you can enable email event notifications.,

Ernail event notifications send messages about error, warning, or informational events and inventory reports to an

email address of local or remote support personnel, Ensure that all the infarmation is valid, otherwise email notification
will be disabled,

[ co r;f-i_g. ure Email Event Notifications

@ Watch e-learning: Configure Email Mokifications

Read 10,10.0.215 [&

7. On the Hardware screen, determine if the hardware graphic display matches
the V7000 physical configuration. If it does not match, reverify the enclosure
cabling. You will be able to renumber the enclosures and rearrange the
enclosures later by drag-and-drop. If the hardware configuration does match,
click Next. Each enclosure is added to the system configuration.
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£7%) IBM Storwize ¥7000 - Mozilla Firefox

File Edit iew History Bookmarks Tools  Help

W (& /2y | SEmGHiA kS https://10.10.0.215/E5etup ad B BE ]

B Most Misited | IBML ﬁ BlugPages | ISVWMZ-IMM | ISYAZ-IMM | ISWW4-IMM | ISWRS-IMM ) ISWRE-IMM | [SVRP-IMM | ISYHEB-IMM 3

=

| || 78G00RR. | 1 | nodel - Home - IBM Stor ... = | .| IBM Storwize ¥7000 * | -

Hardware (Step 5 of 6)

Use this graphic of the attached hardware to
verify that all the installed enclosures and
drives have been detected by the system. If
the enclosure is not displayed, ensure it has
been cabled correctly and is powered on,
Click the enclosure to view details.

6.1.0.7

Transferring data from 10.10.0.215.. hah A

8. Click Close on the Add Enclosure screen; then, click Next.
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Add Enclosure

The task completed,
[

(=) Details

swctask chenclosure -managed yes 3
The task i=s 50% complete.

Tunning commard:

swvctask chenclosure -managed yes 2
The task is 20% complete.

Punning commard:

swctask chenclosure -managed yes 1
Synchronizing mewory cache.

The task is 100% complete.

The task completed.

Cancel

9. On the Configure Storage screen, the Yes, automatically configure internal

storage now check box is preselected. Deselect (uncheck) this box; then, click
Finish.

Important: You must deselect the Yes, automatically configure internal
storage now check box. Do not check Yes, automatically configure internal
storage now under any circumstances. If this box is checked, any storage
pre-configuration performed at the factory will be deleted and you will be
required to re-configure the storage subsystem and reload it manually.
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£7%) IBM Storwize ¥7000 - Mozilla Firefox

File Edit iew History Bookmarks Tools  Help

& -cx o

https: /10, 10.0,215(EZ5etup T I-..]"!Gnogle P
2 Mostisted | IBM1 [TZ BlusPages | | ISVKMZ-IMM | | ISVR3-IMM | | ISVK4-IMM | | ISWXS-IMM || ISV6-IMM | | ISURP-IMIM | | ISYKE-IMM »
| || 78G00RR. | 1 | nodel - Home - IBM Stor ... = | .| IBM Storwize ¥7000 4 | <= |T

Configure Storage (Step 6 of 6)

Would you like to automatically configure internal storage now?
[ ] ves, autornatically configure internal storage now.

Storage Found:
{19 drives) 278.9 GB, 55D
(221 drives) 278.9 GB, SAS, 10000 rpm

Configuration Summary:

9 x SSD Easy Tier (278.9 GB, S5D): 2,2, 2,2, 2,2, 2, 2, 2 drives

1 Hot Spares

0 Unconfigured Drives
30 x Basic RAID-5 (278.9 GB, SAS, 10000 rpm): 8,7, 7, 7, 7, 7, 7, 5, 7, T, 7, 7, 7,
R g R T T d e

10 Hot Spares

0 Unconfigured Drives

[ Finish |

Daone | H &
10. The storage configuration results are displayed. Review the information and
click Close.
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18 Storwize Y7000

The task completed,
[

(=) Details

Tpdat ing license settings
The task is 0% complete.
Punning commard:

swctask chlicense -remote 99
The task i=s L50% complete.
Punning commard:

swyctack chlicenge -wvirtuwalization 39
Synchronizing memory cache.
The task is 100% complete.
The task completed.

11. If the IP addresses of the V7000 storage subsystem need to be changed, use
the steps below to assign new IP addresses. There are three IPv4 addresses

(one management and two service) and one management IPv6 address that
you can set.

a. To set the management addresses, go to the Settings » Network screen and
click Management IP Addresses.
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| Logout

1BM Storwize ¥7000 welcome, superuser Legal

ISY7K3 > Settings > Nebtwork ¥

Management IP Addresses

~

Click on 3 port to configure the system's management 1P address. If you change management IP addresses, you

Management IP
might be required to log in again.

Addresses

A system uses the same management IP addresses for all control enclosures.,
Service IP Addresges

{ Support )]
{ General h!

- ikt a8 & GR35 T6 (%) )

hkkps:fi10,10,0, 203 gui#config-network.

b. Click port 1 and enter the correct management IPv4 address settings; then,
click OK. If there is no IPv6 address set for the IBM Flex System Manager,
select the Show IPv6 check box. Enter the IP Address, Subnet
Mask/Prefix, and Gateway.
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IBM Storwize ¥7000

IS¥7K3 = Settings > MNetwork =

> Management IP Addresses

Management IP
Addresses

Click on a port to configure the system's mana
might be required to log in again.

& system uses the same management IP addn

ST ort 1 (Primary)
2 TPrd TPUE 3
IP Address 10.10.0.203 /
bnet Mask / Prefix ! 255,255.255.0

Gateway]| 10.10.0.1

- 4
Shaw 1796 | e

M r

Service IP Addresses 1

e
"l

isCSI

(o

c. Check to see that the IPV6 address is correct for the V7000 by retrieving
the MAC address of Node 1 Port 1 from the Service interface:
https://<IP_Address_of Service Interface>. Then, enter the MAC
address in the IPv6 calculator.

Note: The Subnet Mask/Prefix value should be 64 and the Gateway
should be either blank or the IPv6 address of the primary CMM.
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Status: Active
Identify

Collect Logs

Manage Systam
Recover System
Re-install Software
Upgrade Manua'l\y
Canfigure Enclosure
Change Service IP
Configure CLI Access

Restart Service
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Current: 01 | 1 | nodel

You can wiew detailed status and error summary, and manage service actions for the current node. The current node is the node on which service-
related actions are performed. The connected node displays the service assistant and provides the interface for working with other nodes on the

system, To manage a different node, select a node from the following table,

Attention: Only perform service actions on nodes when directed by service procedures. If used inappropriately, service actions can cause a loss of
access to data, or even data loss. If the node status is active, select Monitaring--=Events in the management GUI to fix any errors that are related to

the active node,

Make sure Node 1 is selected.

Actions: I Enter Service State 'I GO
| Change Node (/ =
Nod MNode Status  Error Panel System Relationship
o 21 Active 01-1 ISVTKL Local
 node2 Active 01-2 ISW7KL Partner
Refresh I
| Node Errors |
Node Detail =
Node Hardware Access Location
Node Mame: nodel -
Node Status: Active
Part Identity: 11585Ya044v550CG11RXGS
MNode FRU: 85Y5899
Configuration Node: Yes
Model: 100
System: I8WTK1
Systemn Software Build: 54.6,1111250000
Software Version: 6.3.0.0
Software Build: 54.6.1111250000
Console IP: 10.10.0.201:4432
Has File Module Key: no
Fibre Channel Ports ID Status WWPN Type
1 Active S005076802100041  Short-wave
2 Active S0050768022000d41  Short-wave
3 Inactive M 50050768023000d1  Short-wave
4 Inactive e 5005076802400041  Shaort-wave
Ethernet Ports ID Status Speed MAC-Addre
1 Link Online 1Ghys - Full e 1f13:74:2cbb | |
2 Link Online 1Ghyfs - Full = O R M A -

12. Determine if there are any problem events with recommended actions.

a. On the V7000 management interface, go to Monitoring » Events.



IBM Storwize ¥7000

ISY¥7K3 > Home > Overview ¥

= Suggested Tasks =

2 Pools

0 External
Storage Systems

ﬁ Watch e-Learning: Overview
Welcome!

@

A overview
T o

-

The diagram represents all of the objects that need to be conf
diagram. For some objects, e-Learning modules include a tuto
configure these objects, either select the associated task from

P Visit the Information Center

b. Clear any problems in the Actions list by clicking Run This Fix Procedure
under Next Recommended Action and following the directed maintenance
procedure.

1BM Storwize ¥7000

Welcome, superuser Legal | Log

IS¥7K3 > Monitoring > Events ¥

Next Recommended Action

A4 Ethernet port failure{node nodel)
b = Error Code: 1401, Event ID: 051002
i 6 weeks ago
| Run This Fix Procedure’

i= Actions ¥ eRafresh Recommended Actions - @ -
Error Code [Tast Timestamp Description e ]

1401 3632 7.35:00 PM D Alert Ethernet port failuretnode nodet) ethernst_sdapter 2

CeoDmehad

13. Document the Machine Type, Model, and Serial Number (MTMS) of each
storage enclosure and the number and type of disk drives contained in each
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enclosure. You can obtain this information either by visually inspecting each
enclosure or you can use the V7000 management interface. This information
should match the customer shipping documentation.

a. To obtain the MTMS information from the V7000 management interface,
go to Monitoring » System Details; then, click the link for each storage
enclosure.

IBM Storwize ¥7000 "~ . Welcome, superuser

ISY7K3 > Monitoring > System Details =

@ refresn {1 astions =
- [ 1suTKE
(7} / Control Enclosure [1 -
- @@ Enclosure 2*
@ Crive Slats online

+ =3 Canisters

+ [B Power Supply Units Mananed B

~ @@ Enclosure 2
Machine Type and Model | Z2076-324

@ Drive Slats
Serial Number TEGOOPD
+ =2 Canisters
% B Power Supply Units FRU Part Number 855897
| @ Enclosure 3 Part Identity 11585Y59637YGS0CGASZIVO
@ Crive Slots Fault LED Off
+ =3 Canisters 1/0 Group io_grpll

+ [B Power Supply Units
- @@ Enclosure 4
iy Crive Slots
+ ==z Canisters
+ [B Power Supply Units

L= Tl 1T -

b. To obtain the number and type of disk drives, go to Pools » Internal
Storage; then, click each Drive Class Filter. These are the types of disk
drives present. The number of drives of each type are displayed at the
bottom of the screen when you select the drive type.
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IBM Storwize ¥7000 -~ Welcome, superuser Legal | Log

Censohad

031.0 GB, Nearline SAS

7200 rpm e ee——
(" y ?78.9GB, 5AS y weaime. Ve Capacity MDisk Capacity 10,0 TB
L - = Allocation ~
L Shs 10000 rpm SAS Spare Capacity 931.0 GB
ia_grp0 § Total Capacity 10.9TB
278.9 GB, 55D IS Actians ¥ o -
io_grpo - -
Drve I Capaci Use Status MDisk Name Enclosure |y = | Drve Slot
b
931.0 GB, Nearli gas | 68 931.0GE Member Cnling meliskE 4 4
7200 g2 69 9310 GE Member Online  mdiska 4 3
i0_arp
70 9310 GE Member nling mdiskd 4 12
il 931.0GB Member nling mdizkd 4 g
T2 931.0GE Member onling mdiskd 4 T
3 9310 GB Member onling mdiskd 4 B
T4 931.0GE Member Cinline mdiskd 4 11
75 931.0GB Member online mdisks 4 2
76 931.0GE Member Cnline mdiskd 4 10
P I Int | w 931.0GB Member Cniline: mdiskd 4 a
-
°°sstorag:ma 78 9310 6B Member Orline mdiskd 4 2
79 931 NGB Spare [ oniine 4 1

Showing 12 drives | Selecting 0 drives

14. Check the V7000 software level by going to Monitoring » System. The
installed software version is displayed at the bottom of the system diagram.

Note: The V7000 software version will vary over time as later versions are

released. You can obtain the current software version from your IBM
consultant.
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IEM Storwize ¥7000

CoemRsbad

ISV7KS (6.3.0.0)

E— o = < S

Verify storage pools, volumes, and host mappings

The V7000 storage subsystem ships from the factory with one or more storage
pools containing a number of volumes pre-configured and mapped to compute
node hosts in the chassis (depending on the offering).

Power offerings — Express and Standard: eight 600 Gb 10K RPM hard disk drives
(HDDs) and two 300 Gb solid state drives (SSDs). The V7000 uses eight drives in a
RAID 5 configuration to create one storage pool while providing a single hot spare
for resiliency. Storage LUNSs for all of the compute nodes can be created from this
pool.

When the primary compute node is a Power compute node, the following LUNs
are created by IBM Manufacturing:

Type Storage requirement Name

VIOS-1 40 Gb SNTOXXXXX_VIOS1

VIOS-2 40 Gb SNTOXXXXX_VIOS2

(O] 100 Gb SN1OXXXXX_TEMPLATE_OS !

Media 400 Gb SNT0XXXXX_MEDIA

repository

SCE 50 Gb SNTOXXXXX_SCE

1. The Template OS of the client's choice (AIX, IBM i, or Power Linux) has a LUN. Each
volume will be mapped to the single primary Power compute node.

Enterprise: sixteen 600 Gb 10K RPM HDDs and four 300 Gb Solid State Drives.
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x86 offerings — Express and Standard: eight 600 Gb 10K RPM HDDs and two 300
Gb solid state drives. If your x86 configuration includes SmartCloud Entry, the
following LUNSs are created by IBM Manufacturing:

Type

Storage requirement

Name

VMWARE
VMES

500 Gb

x86_Repository

VMWARE
VMES

1300 Gb

x86_VM_Diskl

Enterprise: sixteen 600 Gb 10K RPM HDDs and four 300 Gb solid state drives.

1. Verify the storage pools, volumes, and host mappings by going to Pools »
Volumes by Pool. Click on each pool to view the volumes.

1IBM Storwize ¥7000

ISY¥7K3 > Pools > Yolumes by Pool *

wWelcome, superuser

Legal | Logout | Help

Pnnl Filter

mdiskgrpl
0 Yolume copies
0 bytes Used / 8.1 TE

=]

( mdiskgrp0
mdiskgrp0 _
5 Vaolume copies Online
- 26.0 GB Used /15.0 TR 9 MDisks, 5 Yolume
e copies

Ezsy Tier Active

LT_!‘] ﬁ Mew Yolumme

i 26.0 GB 15.0 TB Capacity
Yolume
Allocation 0% I |

Infrastructure . Cinline
LPAR1 Online
Media_Repository Cnling
Production Cniline
vIoS Onling

|3 200.0 GB GR0S076E5025250021000000000000005
|3 100.0 3B ER0S07650252580021000000000000004
(3] 200.0GB ER0S0755025250021000000000000009
[@ 700.0 GB BR0S07EE028280021000000000000007

|3 40.0GB ER050765025250021000000000000005

Pools -> Volumes by
Pool

Showing 5 wolumes | Selecting 0 volumes

2. Right-click on each volume and select View Mapped Hosts to see which hosts
the volume is mapped to.
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[ R L R S L ey e

] ﬁ Mew Yolurme = Actions =
HName ]

Infrastruc v
HE) Map to Host

LPARA
T Unrnap All Hosts

A view Mapped Hosts f
Productio

VIOS 0 Rename
Ugg Shrink

5 @Expand
Right _
Click S¢ Migrate to Another Poal
- @ Export to Immage Mode
3 Delete

Media_Re

[E Wolurme Copy Actions  #

Properties

Showving 5 wolumes | Selecting 1 wolume (200.0 GB)
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Chapter 5. Configuring the IBM Flex System Manager
management node

Use the information and instructions in this chapter to configure the IBM Flex
System Manager management node.

The first time that you turn on the management node, a setup wizard will load
and walk vou through the initial setup of the management node. See

http:/ /publib.boulder.ibm.com/infocenter/ flexsys/information / topic/|

com.ibm.acc.8731.doc/using_the_setup_wizard.htmll for more detailed information

and instructions.

Complete the following steps to configure the management node:

1.

2.

© Copyright IBM Corp. 2012

Connect an Ethernet cable from a notebook computer to a Chassis
Management Module (CMM) in the chassis.

From a client computer, point a browser to:
https://default IP _address or_host name:8422/ibm/console

where default_IP_address_or_host_name is the IPv4 address of the management
node. The host name can be used if the configuration is assigned through a
DHCP server; otherwise, use the IPv4 static IP address. See[Table 1 on page 17|
for the IPv4 address for the management node. Make sure that the IP address
and subnet of the client computer is set to the same value as the management
node (the default subnet is 255.255.255.0). The IP address of the management
node must also be in the same local domain as the client computer. To connect
to the management node for the first time, you might need to change the IP
properties on the client computer.

On the License page, have your customer review the license information; then,
click I Agree.

On the Welcome page, click Next.

On the Date and Time page, enter the date and time. If a Network Time
Protocol (NTP) server is being used in the configuration, enter the information
for the server; then, click Next.

On the System Level User ID and Password page, keep the default user ID
(USERID), but enter a new password; then, click Next.

Notes:

a. The minimum requirement for the password is eight alphanumeric
characters, two of which must be capital letters, numbers, or special
characters.

b. The pe and root accounts will share this password.

On the Network Topology page, leave the Advanced Routing box unchecked
and click Next.

On the Configure Local Area Network (LAN) Adapters page, select the radio
button for the eth0 adapter and deselect the Perform network validation and
recovery box; then, click Next.

Important: The initial setup wizard will not complete if the Perform network
validation and recovery box is selected.

47


http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.8731.doc/using_the_setup_wizard.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.8731.doc/using_the_setup_wizard.html

48

9.

10.

11.

12.

13.

14.

15.
16.

On the Configure IP Address page, configure the IP address for the eth0
adapter. The eth(Q adapter provides the internal chassis management network
interface for the management node. See the information provided in

for the IP address settings.

Make sure that you match the CMM and internal chassis settings.
Select the IPv6 address box.

Select the Use the following IPv6 radio button.

In the IPv6 address field, enter the IPv6 address.

e. In the Prefix length field, enter 64.

f. Click Add; then, click Next.

On the Configure Local Area Network (LAN) Adapters page, select the radio
button for the ethl adapter; then, click Next.

On the Configure IP Address page, configure the IP address for the ethl
adapter. The ethl adapter provides the data network interface for the
management node. This adapter communicates through the network switch
instead of on the internal chassis management network. Typically, IPv4 is
used. Make sure that you match the data network settings; then, click Next.

On the Configure Local Area Network (LAN) Adapters page next to the Do
you want to configure another LAN adapter? radio button, click No.

a0 o

On the Configure Host and Gateway page:

a. In the Host name IP Address field, enter the IP address of the ethl
adapter (data network).

b. In the Short name field, enter a host name.
c. In the Domain name field, enter a domain name, if available.

d. In the Default Gateway address field, enter the gateway address. If you
did not change the default IPv4 address, see the information provided in
[Table 1 on page 17| for the IPv4 address.

e. In the Default Gateway device field, select the eth1 adapter.

f. Click Next to continue.

On the Configure Domain Name System (DNS) page, enter the DNS
information provided by the customer. If you do not plan to use DNS
services, deselect the Enable DNS services box; then, click Next.

Important: DNS server configuration is required on the data network (ethl)
for the following management software functions:

* Using VMControl to manage virtual machines and operating systems that
are running on compute nodes

¢ Updating the device drivers in the operating systems that are running on
IBM Power Systems compute nodes

Review the information on the Summary page; then, click Finish.

Wait for the setup wizard to process the configuration. When the message
Congratulationa. A1l setup tasks completed is displayed, click Continue.

¢ The management node will restart. Approximately 5 minutes after the
wizard completes the setup, you are prompted to accept the security
certificate for the server. If you want to monitor the status of the process,
you must accept this certification.

Depending on the browser that you use, you might have to accept the
security certificate every time that you log in to the IBM Flex System
Manager management software. With Mozilla Firefox, the warning is
displayed only during initial setup; if you add the exception during initial
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17.

18.

19.

20.
21.
22.

23.

24,

25.

26.

27.

28.

20.

30.
31.

setup, the exception is added automatically in the future. However,
Microsoft Internet Explorer might require you to accept the security
certificate every time you log in.

* When the installation process is completed, the IBM Flex System Manager
login page is displayed.

Using the IBM Flex System Manager web interface and the credentials that
you specified in step log in to the management node.

Note: If a message There is a problem with the website’s security certificate is
displayed, select Continue to this website (not recommended).

From the Home tab, select Flex System Manager Domain - Select Chassis to
be Managed from the Initial Setup tab.

Note: If a message The discovery process is complete. No chassis were found for this
management domain is displayed, click Discover New Chassis.

Make sure that the Run Now radio button is selected, then click OK. (The
status column displays a status of Unmanaged.)

On the right-hand side, select General Actions » Resource Explorer.
On the Resource Explorer Groups page, select All Systems.

Make sure that the Access column for all three objects (Operating System,
Server, and Farm) is OK. If not, click the No access status and provide the
appropriate credentials to unlock them.

When the Access status for all three objects is OK:

a. Right-click on the Operating System object; then, select Inventory »
Collect Inventory.
b. When the Job name and schedule window is displayed, enter FSM 0S in the

Job Name field and make sure that the Run Now radio button is selected;
then, click OK.

c. Right-click on the Server object; then, select Inventory » Collect Inventory.

d. When the Job name and schedule window is displayed, enter FSM Server
in the Job Name field and make sure that the Run Now radio button is
selected; then, click OK.

Go to the Home tab, select the Plugins tab and scroll to Automation
Manager; then, select Active and Scheduled Jobs.

On the Active and Scheduled Jobs page, verify that the inventory is 100%
complete with no errors.

After the inventory collection is 100% complete, go to the Chassis Manager tab
and check the box next to the chassis name; then, click Manage.

On the Manage Chassis page, click Manage; then when the process is
completed successfully, click Done. (The chassis status of Managed should be
displayed.)

Go to the Home tab; then from the Common Links at the bottom of the page,
select Chassis Manager.

On the right-hand side of the Managed Chassis page, select General Actions »
Resource Explorer.

On the Resource Explorer Groups page, select All Systems.

The list of components that are installed in the chassis should be displayed.

The Type column identifies the object type such as a switch, a server, and so
on. If any of the newly discovered systems need access, click the No access

status and provide the appropriate credentials to unlock them:

* For x86 compute nodes, enter the IMM login credentials.
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32.

33.

34.
35.

36.

37.

38.

39.

40.

41.

* For Power compute nodes, enter the FSP password.

When OK is displayed for the Access status, click Close.

Verify that all of the components installed in the chassis and the top-of-rack
switches have been discovered. If not, do a manual discovery on the missing
components.

Notes:

a. All components installed in the chassis should be self discovered. If this is
not the case, check the CMM to see if there are any errors being reported.
An error might be preventing the component from being discovered.

b. Before you discover the V7000 component, you must complete the
inventory discovery and collection procedures for the chassis components.
Instructions for discovering the V7000 component are provided later in this
procedure.

On the Resource Explorer Groups page, right-click the PureFlex chassis object;
then, select Inventory » Collect Inventory.

Select Run Now; then, click OK to start the inventory collection job.

When the window is displayed to inform you that the job was successfully
created, click Display Properties.

When the job is completed successfully, close the Active Scheduled Jobs tab
and return to the Resource Explorer Groups page.

Right-click the PureFlex chassis object; then, select Inventory » View and
Collect Inventory.

Review the inventory and make sure that all components (including the top-of
rack switches, if installed) have been successfully discovered.

To include an external Storwize V7000 as a managed endpoint for the IBM
Flex System Manager, complete the following steps:

a. Log in to the IBM Flex System Manager using the command line interface.
b. Run the smcli manageV7000 command:
smcli manageV7000 -p passwOrd -i <v7000 cluster ip>

C. After you successfully run the command, log in to the IBM Flex System
Manager graphical user interface and go to the Resource Explorer tab.

d. Right-click the Farm object; then, select Inventory » Collect Inventory.
e. Select Run Now; then, click OK to start the inventory collection job.

—h

When the job is completed successfully, close the Active Scheduled Jobs tab
and return to the Resource Explorer Groups page.

g. Right-click the newly discovered V7000 Storage Array object; then, select
Inventory » View and Collect Inventory.
h. Select Run Now; then, click OK .

If you are setting up IBM Flex System FC5022 switches, see |Chapter 6, ”Setup|
fand discovery for FC5022 switches,” on page 53|

To verify the overall storage configuration, log in to the IBM Flex System
Manager command-line interface (as user USERID) and execute the following
command:

smcli dumpstcfg

Note: The output from this command provides a listing of the following:
* All of the SAN Switches
* All of the SAN Zoning
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 All of the Storage Controllers
* All of the Host Accessible Containers (Storage Pools)

42. Return to [Chapter 2, “Installing the IBM PureFlex System offerings,” on page|

El and continue with step[8 on page 5
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Chapter 6. Setup and discovery for FC5022 switches

This chapter includes tasks for setup and fabric discovery of the IBM Flex System
FC5022 24-Port 16Gb SAN Scalable Switch.

Initial setup

Complete this task to set up the FC5022 Switch.

Note: This task assumes that the switch default password for snmp is not set. If
the password and userid have already been created, skip this task and go to
[“Fabric discovery” on page 54)

1. SSH into the FC5022 switch.

2. Enter the following command. This command lists all of the users:
snpconfig —show snmpv3
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3. Enter the following command to set the user and password:

snmpconfig —set snmpv3

Fabric discovery

Complete this task to perform fabric discovery and collect inventory for the
FC5022 Switch.

Fabric discovery is done in two stages, the first stage using the SMIA tool
application and the second using FSM Storage Management. Both are available
from the FSM home page.

1. From the home page, go to the Applications tab.

Use these tabs to perform some initial setup tasks, view or activate plug-ins, perform administration tasks, and access additional Check and Update Flex System Manager
information. Infarmation Center

Initial Setup Additional Setup @ Plug-ins Administration Applications Learn
Use this tab to work with applications designed to extend the capabilities of the IBM Flex System Manager™.

Refresh October 24, 2012 1:33:20 PM CDT

Jl IBM Fabric Manager ::

MF Fabric Manager is an address virtualization tool.
[&d Running

Start St Restart

Launch administration consale

| SMIA Configuration Tool 1.1
The SMI Configuration Tool provides the ability to connect to and manage Brocade top-of-rack switches. Use this application to discover these switches, view
their configuration, and monitor their status.

&) Stopped

Start Stop

Launch administration console

2. Start the SMIA Configuration Tool. The tool state should change to Running
with in 10 minutes. However, the screen does not automatically refresh. You
must refresh the screen to see the tool state change.
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Use these tabs to perform some initial setup tasks, view or activate plug-ins, perform administration tasks, and access additional Check and Update Flex System Manager
information. Infarmation Center

Initial Setup | Additional Setup @ Plug-ins __ Administration | Applications | Learn

Use this tab to work with applications designed to extend the capabilities of the IBM Flex System Manager™.

October 24, 2012 2:15:24 PM CDT

%;; IBM Fabric Manager .
Fabric Manager is an address virtualization tool.
Running

Start Stop Restart
Launch administration console

|'j SMIA Configuration Tool 14
The 5MI Configuration Tool provides the ability to connect to and manage Brocade top-of-rack switches. Use this application to discover these switches, view
their configuration, and monitor their status.
ﬂ Running
Start Stop
Launch administration console

3. Once the SMIA tool is running, launch the console to get to the network
adviser. Use your FSM userid and password. Make sure that you update the
laptop where you launch your FSM GUJ, it must have the host name of your
FSM in the etc/hosts file. In this example, the host name for the FSM is
x1123fsm.

Enter Uzer 1D and Pazsword to log onto the server

Network Address 9.5 54 89

Server Name !x1 123f=m

User ID lUSERID |

Pazsword |--||---| |

| Login | Exit |

[v] Save pazzword

(i) Server Avaiatle

After login, the SMIA Configuration Tool home screen is displayed:
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g ol

[ sl

[ Home || Authentication | CIMOM | Certiicate Management | Summary |
Y'ou can launch the following IBM Network Advizor dialogs by clicking on the links.
Fabric Discovery - Configuring fabric discovery will let the application discover products connected to the SAN.
Haost Discovery - Configuring hest discovery will let the application discover devices connected to the SAN.
Users -“ou can configure the user, user roles and area of responsibility.
Options - Displays all the configurable options available in the management application.
Server - Displays various properties of the server.

About - Displays the application build, java version and trademark information.

Cloze I Help |

4. Click Options. On the Options screen under Software Configuration, select
Product Communication. Select Connect using HTTPS (the default comes up
as HTTP). Click Apply, then click OK.

Note: Before proceeding, go back to the SMIA Configuration Tool, stop the
application; then, restart the application.
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Category Uz« thiz option to configurs HTTP or HTTPS connections between the IBM Network Advisor
T Server and SAN switches.

Event Storage

Look and Feel i) Connect using HTTP

SAN End Node Display Port # a0

SAM Ethernet Loss Events Cutrent Pord # :SI}

SAN Names =

Security Misc Default Port # (B0

o g ) Connect using HTTPS (HTTP over SSL) only
Syelog Registration

Trap Registration Port # 443 |

Trap Ferwarding Credentials Current Port 2 5;143

[ Software Configuration o o
Client Export Port R i
Client/Server P

Memary Allocation
Product Communication

FTPISCP
Server Port
Support Mode

'@ Changes wil take effect at the next application restart

1
oK 1 Cancel! Apply | Help |

5. Once step has completed and the SMIA Configuration Tool is
[ on page 53

running, launch the SMIA console and log in as in step 5| (note
that you lose the SMIA configuration screen when you stop the tool ). Once
you get to the SMIA Configuration Tool home screen, select Fabric Discovery.
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32 Biscover Fabrics

Use the Add button to dizcover a Fabric,

| Dizcovered Fabrics
|

Hame

P Address  |WWN Dizcovery Status |cor

| »

Name VAN User D Community Strin

Chse | e |

58

6. Click Add on the Discover Fabrics screen. You will see the Add Fabric
Discovery screen. The screen default for SNMP Configuration is Automatic,
change it to Manual. Enter a fabric name of your choosing, enter the IPV6
address of your FC5022 switch, and enter the userid/password of your FC
switch.
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o

=@ Add Fabric Discovery @é‘g

[P Adoress [ SN |

SNMP Configuration (73 ajtomatic (@ Manual

Fabric Mame

IP Addrezs

Uszer D

Pazsword

@ U=zer I and Password iz not required for m-EOS switches.

0K | Cﬂl‘IDE1| Help !

7. Click the SNMP tab. If admin2 was created as userid, then enter that as the
User Name. Leave Context Name blank, set Auth Protocol to MD5, and set
the Auth Password to admin?2. In this example, for Priv Protocol use AES128

and the password is admin2 (the password is whatever was created in
[setup” on page 53).

X

23 Add Fabric Discovery

((PAddress | st |
Target Port || © Time-out (2ec) (5 | Retries (3
SHNKP Verzion B
Prezets = Configure for Intrepid 10K
Llzer Name |sn rpadmin |
Context Name | |
Auth Protocol - None - - |
Priv Protocol - Nong - il |

Ok | Canc&l| Help |
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8. Once step has completed you will see the Discover Fabrics
screen. This screen shows two examples that could be the outcome of the
previous steps. One has completed successfully (fabric named Van the man
#3). There are two fabrics in the Van the man #3 configuration, one is a
FC5022 16GB chassis switch and the other is an IBM 2490 B24 (Brocade)
top-of-rack switch. The Brocade TOR switch in this example was not set up.
The second fabric in this example (Van the man #4 ) failed because the snmp
userid /password were not set or were not entered correctly.

@3 Discover Fabrics %
Use the Add button to dizscover a Fabric.
Dizcovered Fabrics
| Name IP Addrezs WIWN Dizcovery Status !f‘ String User ID
Bl &b Van the man #3 Add
+ FCS022 FD8C:2150:1... 10:00:00:05:33:92:67.85 Discovered: Seed Switch i admin |
& IBM_2498_B24  9.5.52.4% 10:00:00:05:22:C0:74:40 Discovered: Mot Reachable : Not registered for SNMP Traps ekt admin — |
= &vantneman“ Jele
& FC5022 FD3C:2150:1... 10:00:00:05:33:93:152A Dizcovered: SNMP communication failed. SNMP credentiale may be invalid. ... = admin
& IBM_2498_B24 5553108 10:00:00:05:33:C0:4B:6D Discovered: Mot Reachable - SNMP communication failed. SNMP credential .. == admin
s
| IP Address [Type [name WN User D c ty String

7
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9. After step EI has completed and there is a check mark by the FC fabric that
you want to discover, go back to the FSM home page and select the Plug-ins
tab. From this screen, select Discover from Storage Management.

Remote Access :::
Ready
Setup Remote Control

Storage Management s::
Ready, IBM Flex System Manager Storage Control (4.2.2.136) installed
SMI-5 Providers Discover Storage

Systems And Volumes Storage Subsystems And Volumes
Deactivate Storage Control

Network Control ::0

Ready
View all network systems Metwork System Pools
Deactivate Start Service Fabric Provisioning Evaluation Period

Learn more about Service Fabric Provisioning
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10. You will see the Discover Storage screen. Select the FC5022 switch from the
Select storage device type pull-down.

Discover Storage

Use discover storage to discover and automatically collect inventory for manageable storage resources, including Fibre Channel switches and storage subsystems.

r"_?- Learn maore about discovering storage devices

Select storage device type:
- select - | "]

Cancel |

11. On the Specify Settings screen, enter your FSM Farm IPV6 address for the
SMI-S IP address. Make sure to change the port number from 5989 to 25989
and enter your FSM login credentials. Click Discover.

Specify Settings - FC Switch

Discover CIMOM- and SMI-S5-managed Fibre Channel switches, such as a Brocade storage area network (SAN) switch. For SMI-S managed
devices, use the IP address or hast name of the SMI-S provider. If you specify an SMI-S provider that manages multiple storage components, all
the supported storage devices that the provider manages are discoverad.

SMI-5 IP address or host name:

5989

Username:
Password:

Interoperability namespace:

finterop

Protocol:

Automatically run inventory when discovering devices

| Discovar ‘ | Cancel |

Note: You can get the FSM Farm IPV6 address from the FSM GUI:

¢ From The FSM GUI home page, go to Administration> Configuration »
Configure Network. On the resulting screen go to ethl and check the IPV6
address, but don’t set it.

* Go to Resource Explorer>All Systems, select Farm, then Properties. The IP
address is listed.

12. After step [L1| has completed, you will need to inventory the FSM Farm:
a. Go to the Resource Explorer tab.
b. Right-click the Farm object; then, select Inventory » Collect Inventory.
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C. Select Run Now; then, click OK to start inventory collection. After the task
completes, you should see one or more new switches in the listing.

d. Select all of the newly discovered switches and click the Actions button;
then, select Inventory » Collect Inventory.

e. Select Run Now; then, click OK.

13. After you have completed this task, return to|Chapter 5, “Configuring the IBMI
Flex System Manager management node,” on page 47|and continue with step

41 on page 5(]
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Chapter 7. Configuring virtual servers

This topic provides information about configuring virtual servers for the IBM
PureFlex System Express®, Standard, and Enterprise solutions.

Power Systems virtualization

This topic provides information about Power Systems'" virtualization. This topic
describes capturing, deploying, and importing virtual servers. It also describes
importing virtual appliances, and provisioning virtual appliances and workloads
into server system pools.

Note: The tasks in this section are specific to Power nodes with AIX. Task steps
might be different for Power nodes with IBM i, Red Hat, or SUSE Linux.

Creating virtual servers through IBM Flex System Manager
management software or VMControl

Use the information and instructions in this topic to create virtual servers through
IBM Flex System ' Manager management software or VMControl.

1. Access IBM Flex System Manager management software and navigate to the
Manage Power Systems Management page or VMControl function.

2.
3.

© Copyright IBM Corp. 2012

Verify that a node is discovered and in the proper access state.

Verify that the factory preload VIOS has been installed on a virtual server

resource.

a. From the Manage Power Systems Resources page click the host. A list of
virtual servers on the selected server is displayed.

b. Start all VIOS servers on the primary Power Systems node.

C. The presence of the preloaded VIOS can also be verified from VMControl.
Navigate to the VMControl Enterprise Edition page of the IBM Flex System
Manager management software. Click the Virtual Server/Hosts tab and
review the navigation tree of the server for the VIOS preload virtual server.

d. Verify the TCP/IP configuration on the VIOS servers. For Express and

Standard offerings, the IP address assigned is on top of the shared Ethernet
adapter.

Verify the presence of the VIOS media library.

a.

From the Manage Power Systems Resources page or VMControl Virtual
Servers/Hosts tab right-click the compute node with the VIOS preload. The
VIOS must be started. From the Context Menu click System Configuration
> Virtual Resources > Virtual Storage Management.

Select the VIOS, if more than one is defined on a compute node. Choose a
VIOS from the drop-down box and click Query.
The query returns a page with all available virtual storage on the selected
VIOS. Select the Virtual Optical Media tab. The preloaded install ISOs are
shown under the Virtual Optical Media section.

Verify that a factory preload template operating system is installed.

The next task you complete depends on the offering you are configuring:

Power Systems Express offering: Return to [Chapter 2, “Installing the IBM|
[PureFlex System offerings,” on page 5|and continue with step |9 on page 6I
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* Power Systems Standard offering: Go to|“Capturing virtual servers.”]

* Power Sﬁrstems Enterprise offering: Go to [“Creating server system pools” on|
page 68,

Capturing virtual servers

Use the information and instructions in this topic to capture virtual servers.

Capturing virtual servers is one method of populating an image repository with a
virtual appliance. The other is importing an open virtualization format (OVF)
image (see|“Importing virtual appliances” on page 66)).

1. Prepare the virtual server for capture by discovering, accessing, and
inventorying the operating system on the virtual server through IBM Flex
System Manager management software. For more information about IBM Flex
System Manager management software, see |http://publib.boulder.ibm.com /|
infocenter/flexsys/information/topic/com.ibm.acc.8731.doc/|
product_page.html} Also, prepare the virtual server by running the activation
engine (AE) on the operating system.

a. Activate the virtual server to be captured through the Manage Power
Systems Resources page available through IBM Flex System Manager
management software or the VMControl Virtual Servers/Hosts tab.
Right-click the object and select Operations » Activate Path. For more
information about VMControl, see |http:/ /publib.boulder.ibm.com /|
infocenter/flexsys/information /topic/com.ibm.acc.8731.doc//
product_page.html|

b. Verify the TCP/IP configuration for the virtual server to be captured.
c. Verify SSH functionality is installed.

d. Once the virtual server is activated and operational the operating system
must be discovered. Selecting System Discovery under Common Tasks is
one of several ways to access the System Discovery page.

e. Enter the IPv4 address of the operating system associated with the virtual
server, then click Discover Now.

f. When the discovery process has completed, the operating system object is
shown in the list at the bottom of the page.

0. Verify CAS RSAP is present by right-clicking OS object/security/configure
access. Access can be requested by clicking Request Access or returning to
the System Discovery page and clicking the No access link. In either case
the credentials for the operating system are requested. In the case of AIX® it
will be root/currentpassword.

When access is provided, the access changes from No access to OK.

h. Right-click on the operating system object to select the Inventory/Collect
Inventory option and click OK to run the job.

i. Install and run the Activation Engine (AE) on the operating system. The AE
code for various operating systems is available through IBM Flex System
Manager management software at:

/opt/ibm/director/proddata/activation-engine

For AIX or Linux operating systems installed on Power Systems, the package
needed is:

vmc.vsae.tar
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k.

For information on installing the activation engine on IBM i, see

http:/ /publib.boulder.ibm.com /infocenter/flexsys/information /topic/|

com.ibm.acc.8731.doc/ getting_started.html|

Normal access to IBM Flex System Manager management software is
through a restricted shell. One way to obtain the package is through the
following:

login FSM command Tine

cp /opt/ibm/director/proddata/activation-engine/vmc.vsae.tar
scp to workstation or directly to 0S

Note: scp will not be available on a base AIX install.

For an AIX example, create a /tmp/AE directory for the AE package. Then
extract and install the AE package using the following steps:

cd /tmp/AE

tar -xvf vmc.vsae.tar

set JAVA_HOME

which JAVA

export JAVA HOME=/usr/javab/jre

echo $JAVA_HOME

./aix-install.sh

Run the AE to prepare the OS/virtual server:
/opt/ibm/ae/AE.sh --reset O(system will shutdown automatically)

Note: If the AE has been run previously, the following commands must be
run to prepare for a new execution of the AE:

rm /opt/ibm/ae/AP/*

cp /opt/ibm/ae/AS/vmc-network-restore/resetenv /opt/ibm/ae/AP/ovfenv.

xm]

/opt/ibm/ae/AE.sh --reset

2. Access IBM Flex System Manager management software and navigate to the
VMControl function.

Navigate to the Virtual Appliances tab of VMControl and verify the existence
of an image repository.

3.

From the VMControl page click the Virtual Appliances tab. Review the count
of image repositories. At least one image repository is required to proceed.

Use the Capture Wizard to capture a virtual server as a virtual appliance and
add it to a VMControl image repository.

a.

From the VMControl page, click the Virtual Appliances tab. Next, click the
Capture link and follow the wizard steps.

When the Capture Wizard starts, click Next.

Enter a name for the new virtual appliance and any other optional
description or search tag information. Click Next to continue.

Select Virtual Server and click Next to continue.
The wizard shows all eligible virtual servers that can be captured.

Note: State must be in a Stopped condition before a capture can occur.
Click Next to continue.

The next page of the wizard shows the disks that are associated with this
virtual server. If the virtual server has multiple disks, they will all be shown
on this page. You also have the option to deselect disks if desired. You can
add descriptive text in the Disk Description field. Make any changes and
click Next to continue.
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0. The wizard indicates the Network Mapping (virtual adapters) that are seen
in the virtual server. The description field can be scrolled to see the details
associated with these virtual adapters. Click Next to continue.

h. As images are captured version trees are created to track the changes. Click
Next to continue.

i. Review the Summary page and if any changes are required, click Back.
If no changes are required, click Finish to complete the wizard.

j. The completion of the wizard brings up the Job Scheduler page. The name
of the job can be edited later for easier identification. Also, the job can be
run immediately or scheduled to be run in the future.

Click OK to run the capture job.

k. When the job starts you have the option to review the progress of the job.
Click Display Properties.

I. When the job properties are shown, click the Logs tab to review or monitor
the progress of the capture job.

m. When the job completes and you return to the VMControl page, the Virtual
appliance section is updated with the newly imported virtual appliance.

5. The next task you complete depends on the offering you are configuring:

* Power Systems Standard offering: Go to [“Importing virtual appliances.”|

* Power Systems Enterprise offering: Go to [“Importing virtual appliances.”]

Importing virtual appliances

Use the information and instructions in this topic to import virtual appliances.

Importing a virtual appliance is one method of populating an image repository
with a virtual appliance. The appliance is created through the importation of an
OVF image. Another method is through a direct capture of a virtual server and is
detailed in [“Capturing virtual servers” on page 64

1. Access IBM Flex System Manager management software and navigate to the
VMControl function.

2. Navigate to the Virtual Appliances tab of VMControl and verify the existence
of an image repository.

From the VMControl page click the Virtual Appliances tab. Review the count
of image repositories. At least one image repository is required to proceed.

3. Use the Import Wizard to import an OVF image into a VMControl image
repository.
a. From the VMControl page click the Virtual Appliances tab. Next click the
Import link and follow the wizard steps.
b. When the wizard starts, click Next to proceed.

c. The OVF image that is being imported must be accessible to IBM Flex
System Manager management software. Enter the location of the OVF image
and click Next.

d. The wizard searches for a digital signature for the OVF image and
determines the disposition of the image if one does not exist.

A digital signature is a code that uniquely identifies the source of the
virtual appliance package. The purpose of the digital signature is to prove
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k.

that the virtual appliance package was sent by an entity that has access to
the private or shared-secret symmetric key used to authenticate the
transmission. Click Next to continue.

The wizard shows the name of the OVF and any description that might
have been added during the creation of the OVF image. The name cannot
be changed at this time but the description and search tags can be modified.

Make any changes and click Next to continue.

As images are captured version trees are created to track the changes. Click
Next to continue.

Review the Summary page and if any changes are required, click Back.
If no changes are required, click Finish to complete the wizard.

The completion of the wizard brings up the Job Scheduler page. The name
of the job can be edited for easier identification. Also the job can be run
immediately or scheduled to be run in the future.

Click OK to run the import job.

When the job starts you have the option to review the progress of the job.
Click Display Properties.

When the job properties are shown, click the Logs tab to review or monitor
the progress of the import job.

When the job completes and you return to the VMControl page, the Virtual
appliance section is updated with the newly imported virtual appliance.

4. The next task you complete depends on the offering you are configuring:

* Power Systems Standard offering: Go to [“Deploying virtual servers.”|

* Power Systems Enterprise offering: Go to [“Deploying virtual servers.”|

Deploying virtual servers

Use the information and instructions in this topic to deploy virtual servers.

1. Access IBM Flex System Manager management software and navigate to the
VMControl function.

From the VMControl page click the Virtual Appliances tab. Review the count
of image repositories and virtual appliances. At least one image repository and
one virtual appliance are required to proceed. If none exist, see [“Capturing]
[virtual servers” on page 64 and [“Importing virtual appliances” on page 66| for
information on creating virtual appliances by capturing and importing
methods.

2.

Click Deploy virtual appliance to start the wizard.

Deploy a virtual appliance using the VMControl wizard.

a.

From the VMControl page click the Deploy virtual appliance link shown
above to start the Deploy Wizard. When the wizard starts, click Next to
continue.

Select the virtual appliance to be deployed. Click Next to continue.

c. The Deploy Wizard shows the target selection for the deployment. Eligible

servers and virtual servers are listed.
Click Next to continue.

The virtual appliance when deployed is known as a workload. Provide a
name for the workload and click Next to continue.

Assign the storage associated with the deployment to a storage pool. The
Storage Mapping page assigns which storage pool will be used when a new
LUN is created for the workload. Click Assign to Storage Pool to see the
available storage pools.
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f. Click an option then click OK.
g. Click Next to continue.

h. Next, the wizard assigns the virtual adapters to the virtual networks that
are available on the target server. Click Next to continue.

i. Use the Product page to assign additional network information such as host
names/domains, IP address/mask/gateways and DNS server. There is a
section for each virtual adapter. Complete the information and click Next to
continue.

j- Review the Summary page and click Back if changes are needed.

k. Click Finish to complete the wizard and bring up the Job Scheduler page.
The name of the job can be edited for easier identification later. Also the job
can be run immediately or scheduled to run later.

Click OK to run the deploy job.

I. When the job starts you have the option to review the progress of the job.
Click Display Properties.
m. When the job properties are shown, click the Logs tab to review or monitor
the progress of the deploy job.

n. When the deploy job completes you can close the Job Properties tab and
review the VMControl under the Workloads tab. The deploy workload will
be shown.

5. The next task you complete depends on the offering you are configuring;:

+ Power Systems Standard offering: Return to [Chapter 2, “Installing the IBM|
[PureFlex System offerings,” on page 5/and continue with step |9 on page 6|

+ Power Systems Enterprise offering: Return to [“Provisioning virtual|
[appliances and workloads into server system pools” on page 69.|

Creating server system pools

Use the information and instructions in this topic to create server system pools.

1. Access IBM Flex System Manager management software and navigate to the
VMControl function.

2. Navigate to the System Pools section of VMControl.

a. From the VMControl page click the System Pools tab and click Create to
start the Create Systems Pool Wizard.

b. The Create Server System Pool Wizard starts. Click Next to continue.

c. Type the name of the system pool in the Name space. Click Next to
continue.

d. Define the pooling criteria. The first check box is for resilience criteria, or in
other words systems that are capable of live partition mobility (LPM). LPM
requires a PowerVM® Enterprise license and a VIOS virtual server that has
been enabled as a mover service partition (MSP). The default setting is for it
not to be checked. The other selection is for network systems pools.

e. Click Next to continue.
f. Select the initial host. The type of host selected on this page will be used

later to filter what types of additional hosts can be added to the pool. Select
the host and click Add to add it to the list. Click Next to continue.

g. Select the V7000 storage pool from the drop-down box, and click Next to
continue. The storage pool or pools shown in the drop-down box are
associated with the initial host. Additional hosts added must also be able to
see the same V7000 storage pool.
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Note: Do not confuse V7000 storage pools with VMC storage pools; they
have different meanings.

h. The wizard displays the eligible additional hosts that passed the filtering of
LPM and storage pools. Multiple additional hosts might be available,
although for Enterprise configurations there are only two prime nodes: one
initial host and one additional host. Click the check box in front of the
desired host and then click Add to populate the list. Click Next to continue.

i. Select manual or automatic optimization of the system pool. Click Next to
continue.

j. Review the Summary page and if any changes are needed, click Back.
If no changes are needed, click Finish to complete the wizard.

k. Unlike most jobs within IBM Flex System Manager management software,
creating a system pool runs immediately and does not offer the option of
being scheduled for a later time. To review the job properties and log
information, click Display Properties.

When the job completes the new system pool is shown together with status
information. The system pool is now ready to be used as a deploy target up
to the limits of the pool.

3. Power Systems Enterprise offering: Go to [‘Capturing virtual servers” on page

Provisioning virtual appliances and workloads into server
system pools

Use the information and instructions in this topic to provision virtual appliances
and workloads into server system pools.

Deploying to a server system pool works similarly to deploying to a specific target
server, but you are only shown the server system pool(s) to choose from.

Power Systems Enterprise offering: Return to [Chapter 2, “Installing the IBM|
IPureFlex System offerings,” on page 5 and continue with step [9 on page 6

X-Architecture virtualization in a VMware vSphere environment

Use the information and instructions in this topic to configure X-Architecture®
virtualization in a VMware vSphere environment. This topic also describes
provisioning virtual appliances and workloads into VMware clusters.

Requirements for virtualization

This topic describes the information, tools, software packages, and software license
requirements for virtualization through VMware vSphere management.

Before you begin, make sure you have the following information:
* Host names for each compute node

* Management network IP addresses for each compute node
* vMotion network IP addresses for each compute node

* Host names and IP addresses for the vCenter Server

¢ IP subnet masks

* Gateway IP addresses

* DNS addresses

* Passwords for the root account on the vSphere Host
 User accounts and password for the database server

» User accounts and password for the vCenter Server
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You might need one or more of the following tools:
e SSH tool (for example, PuTTY)
e SFTP client (for example, WinSCP)

You must have the following software packages available:
* vCenter 5 media

Note: The compute node comes with vSphere 5 Update 1 on an embedded USB
key.

* Windows 2008R2 Server 64-bit media

+ (Optional) An enterprise database media (for example, DB2®, MSSQL, Oracle)

You must have the following software licenses:

* vSphere 5

* vCenter 5 Server

* Windows 2008R2 Server

* (Optional) a license to the enterprise database

Go to [“Configuring virtualization.”]

Configuring virtualization

Use the information and instructions in this topic to configure the virtual
infrastructure and create a vCenter server.

1. Use vSphere Host to define the host name for the host, and the IP address for
the management network to which the vSphere Client and vCenter Server will
communicate.

The first time you log into the IMM, if a DHCP server is not available on the
same network as the vSphere Host, the default static IP address is
192.168.70.125. The default user ID is USERID and the password is PASSWORD
(with a zero, not the letter O).

If you plan to transfer media images (for example, ISO for Windows 2008
Server) to the datastores on this host, it might be necessary to enable the ESXi
Shell and the SSH features on this host. Click Troubleshooting Options and
once the transfer is complete, close the access to enforce a high security level on
the host.

2. Create the vCenter Server.
a. Using a web browser, point to the IP or host name of the vSphere Host.
b. On the Welcome page, initiate the download of the vSphere Client.
c. Using the vSphere Client, log into the vSphere Host.
d

. Start the New Virtual Machine Wizard to create a Windows 2008R2 64-bit
server.

e. Create the workload as a two microprocessor, 8 GB of memory, and 60 GB
hard disk drive server.

f. Follow the Windows Installation Wizard to complete the 2008R2 installation.
g. Install VMware Tools.

h. If you plan to use the Update Manager plug-in, create a second hard disk
drive of at least 100 GB for the software repository.

i. Attach the vCenter media to the virtual server, power on the vCenter Server
and begin the installation process.

j. Select to use the embedded SQL 2008 Express database.
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k. Optionally, to use an external database, obtain the database user ID,
password, and connection point, and create an ODBC Data Source
Administrator entry on the vCenter Server using the SQL Native Client
driver.

|. Select to create a stand-alone VMware vCenter Server instance.
m. Retain the default network port allocations and complete the installation.

Note: All environmental settings, access permissions, scheduled tasks, alarm
thresholds and other settings are recorded in the vCenter Server database. For
all production-ready environments, the vCenter Server database must be fully
backed up regularly or be part of a database cluster environment.

The following are the hardware requirements for a virtual shadow server for
use as a backup:

* Microprocessors

Two microprocessors minimum, but four microprocessors is typical.
* Memory

Minimum is 4 GB, but 8 GB or higher is best practice.
* Networking

Allocate a single 1 Gb virtual network adapter that resides on a physical
teamed network configuration of multiple adapters.

* External Database

MS SQL 2005 and 2008, Oracle 10g R2 and 11g, DB2 9.5 and 9.7 are all
supported as the external database. The problem with using the DB2
database is that other vCenter modules such as the Update Manager cannot
also use the DB2 database, so you must deploy a separate MS SQL or an
Oracle database just for these modules.

* Operating System
Windows 2008 or 2008R2, both must be 64-bit versions to support vCenter.
3. Include all available vSphere hosts in the vCenter Server inventory database.

The IP or host name of each host and the password to the root account are
required to add each host into the management environment of the vCenter
Server. If there are virtual servers already running on the host, the objects will
also be added into the inventory for management. This is the case if the
vCenter Server is running on a virtual Windows 2008R2 server.

4. The next task you complete depends on the offering you are configuring:

 X-Architecture Express offering: Return to|Chapter 2, “Installing the IBM|
[PureFlex System offerings,” on page 5|and continue with step |9 on page 6}

* X-Architecture Standard offering: Return to|Chapter 2, “Installing the IBM|
[PureFlex System offerings,” on page 5/and continue with step [9 on page 6}

* X-Architecture Enterprise offering: Go to [“Provisioning virtual appliance|
[and workloads into server system pools” on page 69,

Provisioning virtual appliances and workloads into VMware
clusters

Use the information and instructions in this topic to provision virtual appliances
and workloads into VMware clusters.

The Open Virtualization Format (OVF) and Open Virtualization Appliance (OVA)
transformation standard consists of a folder that contains the virtual machine files
and the configuration description. If moving a folder is too cumbersome, by
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compressing the folder into a single file, an OVA file, you can transport virtual
objects without missing any crucial components in the process. However, the OVA
file must be converted into an OVF format to produce a running virtual machine.
Also, OVF can encapsulate multiple virtual machines to produce multi-tier
application environments.

To deploy from an OVF template, complete the following steps:

1. Upload the template to a ESX data store or copy it to the local disk of the
vSphere Client system.

2. Using the vSphere Client, select File and click Deploy OFV Template.

3. Navigate to the location of the OVF file. The vCenter Server starts the process
of converting and importing the bundled virtual objects into the inventory.

4. Return to [Chapter 2, “Installing the IBM PureFlex System offerings,” on page 5

and continue with step [0 on page 6|

X-Architecture virtualization in a KVM environment

Use the Virtualization Checklist - KVM-based systems topic accessible from the
Goals and corresponding quick start quides table in |http:/ /publib.boulder.ibm.com /|
infocenter/ flexsys/information /topic/com.ibm.acc.commontasks.doc /|
commontasks_intro.html| for information about configuring X-Architecture
virtualization in a KVM environment.
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Chapter 8. Advanced virtualization management

This topic provides information about advanced virtualization management.

Simplifying system deployments using VMware templates

This topic provides information about simplifying system deployments using
VMware templates.

Use VMware templates to automate workflow, reduce manual labor, and simplify
provisioning. You can create a template virtual machine by duplicating an existing
virtual machine and changing the copy into a template virtual machine. You can
also create a template virtual machine by converting an existing virtual machine
into a template virtual machine. The basic difference is that a template virtual
machine can be powered on and a normal virtual machine cannot be powered on.

To start provisioning new virtual machines, click Deploy Virtual Machine from
Template. You can customize each new virtual machine with a predefined
configuration during the provisioning process. And, you can create different
configuration files for future use.

VMware HA and DRS clusters

This topic describes VMware high availability (HA) and distributed resource
scheduler (DRS) clusters and how to create them.

Requirements for VMware HA and DRS clusters

This topic describes the requirements for VMware high availability (HA) and
distributed resource scheduler (DRS) clusters.

To establish a VMware high availability (HA) and distributed resource scheduler
(DRS) cluster, all host candidates must have access to the same storage pool and
have access to the same virtual machine networks. This shared storage volume can
be on Fibre SAN, iSCSI SAN or NAS. To set up the DRS feature in the cluster, all
hosts must have an identical vMotion network connection. This network traffic link
allows the DRS engine to migrate virtual machines, while they are active, from one
host to another with no service disruptions.

The following is a summary of the requirements:
* Shared storage accessible by all cluster candidates.
 All hosts in the cluster must have access to the same virtual machine networks.

e DNS server role is establish in the environment with host records for the ESXi
systems.

e Static IP addresses on the cluster candidates.
* Common vMotion network across all cluster candidates.

* All cluster candidates under the management of a single vCenter server.

Creating VMware HA and DRS clusters

To create VMware high availability (HA) and distributed resource scheduler (DRS)
clusters, complete the following steps:
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From the vCenter user interface, right-click the datacenter object and click New
Cluster.

Right-click the new cluster object and click Settings. Select Turn On , HA , and
DRS.

On the Automation Level page choose the scenario. In most cases, select Fully
automated and the DRS engine makes all the decisions on the workloads and
decides which virtual machine runs on which host in the cluster.

On the next page, click to enable monitoring of host failure and restart virtual
machines. In the Admission Control Policy section of the page, select to have a
percentage of resources set aside for host failure recovery or select the number
host losses tolerable in the cluster.

To include a host in the cluster, click a host candidate and drag the host object
onto the cluster object. You can build a cluster of up to 32 hosts.
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Appendix A.

Detailed network configuration

This appendix contains detailed information about the PureFlex offering
networking environments, including component descriptions, switch
characteristics, point-to-point wiring, and a comprehensive list of IP addresses.

See|Appendix B, “Cabling diagrams,” on page 83| for related information.

Networking components description

The PureFlex platform is similar to previous generations of BladeCenters in that
there is a chassis internal network used for management, network interface
controllers (NICs) on the compute nodes, midplane connectors to the I/O modules
(switches), and the switches themselves.

Ethernet chassis internal network

The CMM provides layer 2 switching for the management network. All of the I/O
module bays and the node service processors (IMMs or FSPs) are connected to the
management network. The FSM management node has a special adapter that
allows it to communicate directly on the management network, enabling common
administrative tasks such as power control and discovery. The CMM has an
external connection that allows one FSM to control multiple chassis. In a single
chassis implementation, the external connection and external switching support is
not required but is included in all offerings so that external devices, like the V7000
storage subsystem, can be managed on the management network.

Note: Communication on the chassis internal network uses IPv6 local link
addresses. An IPv4 address is only required if you are presenting an external
interface.

NICs on the nodes - LOM and mezzanine cards

All nodes have 10 Gb dual-port Emulex BE3 chips. Some models have the chips on
the system board (LAN on motherboard or LOM) and others are on mezzanine
cards. When you have a node with an LOM it is connected in place of mezzanine
card 1 using the periscope adapter.

Midplane connections to I/O module bays

Each node has four connections through the chassis midplane to the I/O bays, one
connection to each bay. Mezzanine card 1 connects to I/O bays 1 and 2 and
mezzanine card 2 connects to I/O bays 3 and 4. In the case of a double-wide
(2-bay) node, for example the 4S Power node, there are eight connections.

The normal convention is to have Ethernet switches in chassis I/O bays 1 and 2.
As with the previous generation of blades there is a hard-wired connection
between the Ethernet ports (ethO, ethl) on the nodes and the I/O bay (and
therefore the switch installed in that bay). If only one Ethernet switch module is
installed, then only the ethO NIC can communicate.

Switch modules
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There are both 1 Gb and 10 Gb switch modules available for the IBM Flex System
chassis, but in the PureFlex offerings, only the IBM Flex System EN4093 10 Gb
Virtual Fabric switch module is used.

Network switches

With the PureFlex offerings there are two versions of the IBM 8264 Virtual Fabric
switch. One version is a conventional top-of-rack switch and the other is a switch
module form factor that fits in the Flex chassis I/O bays. Internally they are the
same switch, so you only need to become familiar with one switch architecture and
interface. Externally, the IBM Flex System EN4093 10 Gb Virtual Fabric switch
module provides a subset of the ports (SFP+ and QSFP+) provided by the IBM
8264.

Switch characteristics

The IBM 8264 switch can provide up to 64 10 Gb connections at near line speed.
There are 48 small form-factor pluggable (SFP+) connections and four quad small
form-factor pluggable (QSFP+) connections. There is also a 1 Gb connection for
external management and a mini-USB serial connection for setup. The switch does
not come with SFPs, the customer must purchase them separately and they must
be IBM qualified (interfaces are not available otherwise). The QSFP connections can
be used for 40 Gb Ethernet or can be subdivided using a dongle into four 10 Gb
connections.

In the PureFlex offerings, the QSFP+ connections are used for trunking or virtual
link aggregation groups (VLAGS). There are SFP+ transceivers that can be used to
connect DAX cables, Fibre, and for 1 Gb connections, RJ45 and Fibre as well. There
are QSFP+ double-ended DAX cables (1 M and 3 M) used for trunking as well as
QSEFPs for use with Fibre.

On the IBM 8264 switch the ports are numbered internally as shown in the
following graphic. Note that the first QSFP+ port is number 1 and the first SFP+
port is number 17.

I EER. e

|

The IBM Flex System EN4093 10 Gb Virtual fabric switch module provides 28
internal 10 Gb connections to the chassis, 10 external 10 Gb SFP+ connections, and
2 external QSFP+ connections. There is also a 1 Gb connection for external
management and a mini-USB serial connection for setup, similar to the IBM 8264.

The same transceivers are used for the EN4093 switch module as are used for the
IBM 8264.

There are four chassis switch module configurations that are used with the

PureFlex offerings:

* Express (single chassis): This configuration has a single stand-alone IBM 10 Gb
switch module with two 10 Gb uplinks (SR Fibre transceivers)

 Standard (single chassis): This configuration has a single stand-alone IBM 10 Gb
switch module with four 10 Gb uplinks (SR Fibre transceivers)

* Enterprise (single chassis): This configuration has two IBM 10 Gb switch
modules, each with four 10 Gb uplinks (SR Fibre transceivers)
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* Enterprise (single chassis with 4-socket Power node): This configuration has two
IBM 10 Gb switch modules with two IBM 8264 top-of-rack switches. Each of the
switch modules has two QSFP+ to SFP+ uplinks (one to each 8264 TOR). The
QSFP connections on the 8264 switches are used for trunking between the core
switches.

In every configuration there are a number of 1 Gb links provided for management
of the switches, CMMs, and the V7000. These links are implemented using RJ45
transceivers plugged into the SFP+ slots in either the switch modules or the 8264
core switch. Note that these transceivers do not auto-negotiate so only 1
Gb-capable devices can be connected to them. See RETAIN tip: for more
information.

Point-to-point wiring configurations

The PureFlex offerings have wiring conventions so that you can predict what each
port is used for and therefore which VLAN or trunk it should participate in.

Express and standard (single chassis)

Express:
* 10 Gb SFP+ external ports 1 and 2 are for the customer data network trunk
* External ports 3 and 4 are unused

* External port 5 is for customer external VM management (1 Gb, using RJ45
transceiver)

* External port 6 is for customer infrastructure management
* External ports 7 and 8 are connected to the CMMs (1 Gb, using RJ45 transceiver)

* External ports 9 and 10 are connected to the V7000 (1 Gb, using RJ45
transceiver)

* External ports 11 through 14 are not activated

Standard:
* 10 Gb SFP+ external ports 1 through 4 are for the customer data network trunk

* External port 5 is for customer external VM management (1 Gb, using RJ45
transceiver)

* External port 6 is for customer infrastructure management
* External ports 7 and 8 are connected to the CMMs (1 Gb, using RJ45 transceiver)

* External ports 9 and 10 are connected to the V7000 (1 Gb, using RJ45
transceiver)

* External ports 11 through 14 are not activated
Enterprise single chassis - No 4S Power node

This configuration has two switch modules, each configured as follows:
* 10 Gb SFP+ external ports 1 through 4 are for the customer data network trunk

* External port 5 is for customer external VM management (1 Gb, using RJ45
transceiver)

* External port 6 is for customer infrastructure management

* External port 7 is connected to a CMM (1 Gb, using RJ45 transceiver)

* External port 8 is connected to a V7000 controller (1 Gb, using RJ45 transceiver)
* External ports 9 and 10 are unused
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* External ports 11 through 14 are used for a VLAG to the other switch module
Enterprise single chassis - With 4S Power node

This configuration has two switch modules and two IBM 8264s configured as
shown below.

Switch modules:
* External ports 1 through 6 are unused
* External ports 11 through 14 are used for a VLAG to the other switch module

* External ports 15 through 18 (QSFP+ ports) are used for a link aggregation
group (LAG) to 8264 #1

* External ports 19 through 22 (QSFP+ ports) are used for a LAG to 8264 #2

Top-of-rack switches:
* Ports 1 through 16 (QSFP ports) are used for a LAG to the other 8264 switch

* Ports 17 through 20 and 29 through 32 are used for a LAG to switch modules #1
and #2

* Ports 21 through 28 are unused

* Ports 33 through 40 are unused

* Ports 41 through 54 are used for customer data network trunks

* Ports 55 and 56 are unused

e Port 57 is connected to a CMM (1 Gb, using RJ45 transceiver)

* Ports 58 and 59 are unused

* Port 60 is connected to a V7000 controller (1 Gb, using RJ45 transceiver)
e Port 61 is connected to a 2948 SAN switch (1 Gb, using R]45 transceiver)

* Port 62 is connected to the other 8264 switch management port (1 Gb, using RJ45
transceiver)

* Ports 63 and 64 are used for customer external management (1 Gb, using RJ45
transceiver)

VLANs

Four VLANSs are used:

* VLAN 4091 - Customer VM management

* VLAN 4092 - Customer data

* VLAN 4093 - Customer infrastructure management
* VLAN 4094 - VLAG ISL

VLAN:Ss - Single chassis Express and Standard

This is for the single switch module in the chassis. There is no tagging required.
* External ports 1 through 4 are data only

 External port 5 is VM management only

* External ports 6 through 10 are infrastructure management only

* All internal ports are for data and VM management only

VLAN:S - Single chassis Enterprise - No 4S Power node
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Since there are two switches there is a trunk between them and a requirement to
carry tagged data over the trunk. The configuration is the same on both switches
from the VLAN perspective.

* External ports 1 through 4 are data only
* External port 5 is VM management only
¢ External ports 6 through 10 are infrastructure management only

 External ports 11 through 14 are used for a VLAG to the other switch module. It
carries all VLANs. VLAG ISIL, VLAG tagged

* All internal ports are for data, VM management, and VLAG ISIL only
VLAN:S - Single chassis Enterprise - With 4S Power node

Since there are four switches there is a trunk between them and a requirement to
carry tagged data over the trunk. The configuration is the same on both chassis
and core switches from the VLAN perspective.

Switch modules:
* External ports 1 through 6 are unused

* External ports 11 through 14 are used for a VLAG to the other switch module. It
carries data only.

* External ports 15 through 18 (QSFP+ ports) are used for a LAG to 8264 #1. It
carries both data and management. Management is tagged.

* External ports 19 through 22 (QSFP+ ports) are used for a LAG to 8264 #2. It
carries both data and management. Management is tagged.

+ All internal ports are for data only

8264 top-of-rack switches:

* Ports 1 through 16 (QSFP+ ports) are used for a LAG to the other 8264 switch. It
carries both data and management. Management is tagged.

* Ports 17 through 20 and 29 through 32 (QSFP+ ports) are used for a LAG to
switch modules #1 and #2. It carries both data and management. Management is
tagged.

* Ports 21 through 28 are unused
* Ports 33 through 40 are unused

* Ports 41 through 54 are used for the customer data network trunks. They are for
data only.

* Ports 55 and 56 are unused
* Port 57 is management only
* Ports 58 and 59 are unused
* Ports 60 through 64 are management only

Network integration considerations

Take the following into account:

1. Physical integration with the customers infrastructure, for example, SFPs and
cabling.

2. Trunks and trunking protocol used between the customers infrastructure and
the machine being installed, for example, PaGP or LACP.

3. Routing for the virtual machine subnet(s).
4. Routing for the FSM virtual machine.
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5. Routing for the external management interface(s), for example, the CMMs.

At the physical link layer, a number of SR-fibre SFPs appropriate for the model
selected are supplied that will attach to customer-supplied fiber from their
switching infrastructure.

There is no need to tie the subnets for the virtual machines to hardware
configuration. These should be addresses that are directly route-able for the
end-user community. This is entirely dependent on the customer and the number
of virtual machines that they expect to host and will likely be negotiated on site
with the customer.

The FSM console virtual machine will likely be accessed by a system administrator.
That virtual machine can be on a subnet that might require special routing for
access. The external management interfaces might also require special routing.

IP addressing

This is the current plan on IP addressing for the platform. Everything will be on
two private subnets:

* 192.168.93.0/24 - For management
* 10.91.0.0/16 - For data

The customer will need to make these subnets route-able in their enterprise, or
perform some form of network address translation, or use a gateway to provide
access.

Note: Selection of this address range can cause some problems if a complete V7000
replacement occurs, as they are configured in the factory with a conflicting IP
address that is in this range. If you encounter a network issue you might want to
check the V7000 configuration first.

Table 2. Comprehensive list of IBM PureFlex System IP addresses

Chassis Component IPv4 IPv6 prefix | VLAN | Username Password

CMM

Chassis 1 CMM #1 192.168.93.100 | fd8c:215d:178e:c0de | 4093 USERID PasswOrd
CMM #2 192.168.93.100 | fd8c:215d:178e:c0de | 4093 USERID PasswOrd

IOM

Chassis 1 IOM #1 192.168.93.120 | fd8c:215d:178e:c0de | 4093 USERID PasswOrd
IOM #2 192.168.93.121 | fd8c:215d:178e:c0de | 4093 USERID PasswOrd
IOM #3 192.168.93.122 | fd8c:215d:178e:cOde |4093 USERID PasswOrd
IOM #4 192.168.93.123 | fd8c:215d:178e:c0de | 4093 USERID Passw0rd

FSM

Chassis 1 eth0 n/a £d8c:215d:178e:c0de | 4093 USERID PasswOrd
ethl 10.91.0.2 £d8c:215d:178e:c0de | 4091 USERID PasswOrd

Compute nodes - Chassis 1

Chassis 1: FSP/IMM 192.168.93.150 | fd8c:215d:178e:cOde | 4093 Same as CMM

r(ligér;plute VIOS/ESXi 10.91.0.2 n/a 4091 |root PasswOrd
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Table 2. Comprehensive list of IBM PureFlex System IP addresses (continued)

Chassis Component IPv4 IPv6 prefix VLAN | Username Password

Chassis 1: FSP/IMM 192.168.93.151 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.4.2 n/a 4091 | root PasswOrd

node 2

Chassis 1: FSP/IMM 192.168.93.152 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.8.2 n/a 4091 | root PasswOrd

node 3

Chassis 1: FSP/IMM 192.168.93.153 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.12.2 n/a 4091 | root PasswOrd

node 4

Chassis 1: FSP/IMM 192.168.93.154 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.16.2 n/a 4091 | root PasswOrd

node 5

Chassis 1: FSP/IMM 192.168.93.155 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.20.2 n/a 4091 |root PasswOrd

node 6

Chassis 1: FSP/IMM 192.168.93.156 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.24.2 n/a 4091 |root PasswOrd

node 7

Chassis 1: FSP/IMM 192.168.93.157 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.28.2 n/a 4091 |root PasswOrd

node 8

Chassis 1: FSP/IMM 192.168.93.158 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.32.2 n/a 4091  |root PasswOrd

node 9

Chassis 1: FSP/IMM 192.168.93.159 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.36.2 n/a 4091 |root PasswOrd

node 10

Chassis 1: FSP/IMM 192.168.93.160 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.40.2 n/a 4091  |root PasswOrd

node 11

Chassis 1: FSP/IMM 192.168.93.161 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.44.2 n/a 4091 |root PasswOrd

node 12

Chassis 1: FSP/IMM 192.168.93.162 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.48.2 n/a 4091 |root PasswOrd

node 13

Chassis 1: FSP/IMM 192.168.93.163 | fd8c:215d:178e:c0de | 4093 Same as CMM

Compute VIOS/ESXi 10.91.52.2 n/a 4091 |root PasswOrd

node 14

Top-of-rack components

TOR V7000 Canister #1 192.168.93.210 |fd8c:215d:178e:c0de | 4093 USERID PasswOrd
Canister #2 192.168.93.211 |£fd8c:215d:178e:c0de |4093 USERID PasswOrd
Cluster 192.168.93.213 | fd8c:215d:178e:c0de |4093 USERID PasswOrd

TOR Ethl Management 192.168.91.220 | fd8c:215d:178e:c0d | 4093 USERID Passw0rd

TOR Eth2 Management 192.168.91.221 | fd8c:215d:178e:c0d | 4093 USERID PasswOrd

TOR SAN1 Management 192.168.91.222 | fd8c:215d:178e:c0d | 4093 USERID Passw0rd

TOR SAN2 Management 192.168.91.223 | fd8c:215d:178e:c0d | 4093 USERID PasswOrd

LPAR/VM
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Table 2. Comprehensive list of IBM PureFlex System IP addresses (continued)

Chassis Component IPv4 IPv6 prefix VLAN | Username Password
Chassis 1: SmartCloud Entry |10.91.0.230 4091 root Passw0rd
Compute VM/LPAR
node 1 vCenter VM 10.91.0.232 4091 | Administrator |PasswOrd

Template OS 10.91.0.233 4091

LPAR (Mgt.)
Varies Guest OS Customer Customer defined | 4091

defined
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Appendix B. Cabling diagrams

This appendix contains cabling diagrams that might be useful during the
installation process.

THIS SECTION IS UNDER DEVELOPMENT

SFP descriptions and usage

The following table provides a high-level overview of the SFPs used in the
Express, Standard, and Enterprise configurations.

AAS |HVEC Description Express Base Standard Base Enterprise Base
Flex System | Storwize Flex System | Storwize Flex System | Storwize
V7000 V7000 >0 | V7000 V7000 =1 V7000 V7000 >0

EB29 3268 |1 Gb on the chassis 4 6 4 6 4 6
3282 5053 |10 Gb on the chassis 2 2 4 4 4 4
EB28 [5063 |10 Gb on the G8264 - - - - - -

TOR switch
AAS |HVEC Description Express Expansion Standard Expansion Enterprise Expansion

Flex System V7000 Flex Storwize -
System V7000 >1
V7000

EB29 | 3268 |1 Gb on the chassis 0 0 2 0
3282 | 5053 |10 Gb on the chassis - - - -
EB28 | 5063 |10 Gb on the G8264 2 2 2 2

TOR switch
AAS |HVEC Description Expansion rules for a one chassis configuration with more than one Storwize

V7000 Storage System and no top-of-rack switches
Express Standard Enterprise

EB29 3268 |1 Gb on the chassis 2 2 2
3282 | 5053 |10 Gb on the chassis - - -
EB28 |5063 |10 Gb on the G8264 - - -

TOR switch

See [“Symbols, feature codes, and descriptions” on page 84 for more information.
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Symbols, feature codes, and descriptions

Use the information in the following table as a legend for the configuration and
cabling diagrams.

MTM or Feature
Feature Code
Symbol Code AAS |HVEC Description
3282 5053 10 GbE SFP
A EB29 3268 1 GbE SFP
& 5370 — (B) 8 Gb GbFC SFP for use with the FC5022 switch and V7000 Storage
System
g{‘gr i?) g 3286 — (Q) 8 Gb GbFC SEP for use with the FC3171 switch and V7000 Storage
(Brocide) System
O EB28 5053 10 GbE SFP
— — Cables called out from the components.
2\ — — Expansion rules
Chassis 1 7893-92X | 8721-HC1 |IBM Flex System Enterprise Chassis
V7000 node 4939-A49  |4939-X49 | IBM Flex System V7000 Storage Node
V7000 node 4939-A29 |4939-X29 |IBM Flex System V7000 Storage Node (expansion)
V7000 system |2076-124 — IBM Storwize V7000 Storage System
V7000 system | 2076-224 — IBM Storwize V7000 Storage System (expansion)
EN4093 switch | 3593 AQTB IBM Flex System EN4093 10Gb Scalable Switch
FC3171 switch | 3595 AO0TD IBM Flex System FC3171 8Gb SAN Switch
FC5022 switch |3771 A2RQ IBM Flex System FC5022 24-Port 16Gb SAN Scalable Switch
G8264 switch |1455-64C | — IBM System Networking RackSwitch G8264
G8052 switch | 1455-48E | — IBM System Networking RackSwitch G8052
SAN switch 2498-B24 | — IBM System Storage SAN24B-4 Express
— 2808 — SFP 8 Gbps SW 8-Pack
ECB4 ECB4 — 1 m IBM Passive DAC SFP+ cable (1455 top-of-rack switch)
ECB5 ECB5 — 3 m IBM Passive DAC SFP+ cable (1455 top-of-rack switch)
EB2B EB2B — 1 m IBM QSFP+-to-QSFP+ Cable
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MTM or |Feature
Feature Code
Symbol Code AAS |HVEC Description
EB25 EB25 — 3m IBM Passive QSFP+ DAC Break Out Cable
EB28 EB28 — IBM SFP+ SR Transceiver
— 7309-HC3 |— 10m IBM QSFP+ MTP Optical cable
Cat 5 Ethernet | ECB2 — 1.5 m Category 5 Ethernet Cable (blue)
1111 3803 3 m Category 5 Ethernet Cable (blue)
Fibre 5305 and |— 5 m Fiber Optic Cable LC-LC
5605

Express configurations

This section provides illustrations of the Express configurations.

Express configuration with a V7000 storage node

Cat5 Ethemet .

Chassis 1

Customer or manufacturing

Cable not provided

-_'_L' A b l l

EN4093 switch in O bay 1

Use odd-numbered ports
for modules in /O bays 1and 3

bd d bd bd bd

b e rod b
3=l === === == ==

| | =i = =} = = = | | |
OOOOC‘
w0

SFSERSIS

|| FC5022 switch
7| FC3171 switch

See ["Symbols, feature codes, and descriptions” on page 84 for the key to the
symbols used in the illustrations.
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Express configuration with a V7000 storage system

Cat5 Ethemet” =~
. [ 1] 2] 3] 4] 5] 6] 7] 8] o[ 1911 12]

Chassis 1 EN4093 switch in 1/O bay 1

110
bay 3

31| FC5022 switch
FC3171 switch

Fibre

v7000-1 jcaM_IN_[cand_IN | [ v7000-2 [can[ IN_|can[ IN

2076-224| 1ouT| ZouT] |2076-224 ‘IIOUT ZIOUT

- I | _ I L Maximum
v7000-3 CANLIN_JcAN_IN ] | v7000-4 |cANLIN_|can[ IN of 10
12076-224|  1guT| 2ouT| 2076-224| 1ouTt|l 2louT Enclosures

V7000-x (CANLIN_[can[_IN_| | v7000-x CANLIN |cAn[_IN
2078-224| 1out| ZouT]| 2076-224] 1ouT| 2loUT

See [“Symbols, feature codes, and descriptions” on page 84 for the key to the
symbols used in the illustrations.
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Express configuration with V7000 storage node expansion

Customer or manufacturing

Cable not provided

- Pl

Cats Ethem’EaI,Y-I ..... C 1 l

1] 2] 3] 4| 5| 6] 7] 8] 910/ 1112
Chassis 1 EN4093 switch in /O bay 1

Optional:

-1xSRC + 1xExp
| -2xSRC

-2xExp

FC Mezz 1

Use odd-numbered ports
for modules in /O bays 1 and 3

z|z|z|z|z|z|Zz|z|Z| z| z|z| z| z| =| =z| =| =| z| z| z| =z| =| =z| z| =z| =| =
e e e e e e e e e
O|0|0|0|I0(0|0| 00|02 O0O|0|0 00| === = =2 == 2 =2
S2NIN|W W BIBIOOD(0| N[00 O|OIO|O|= =N N w| W] I B
pSles] B lsl b lss 1 BSTee] b [eel by s ] BN e Sl e sl o b I ] B el S [es b e S

/O FC5022 switch
bay 3 FC3171 switch

See [“Symbols, feature codes, and descriptions” on page 84| for the key to the
symbols used in the illustrations.
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Express configuration with V7000 storage system expansion

V7000-1
Customer or manufacturing [(2076-124)] CAN 1 |CAN 2|

Ethemet

Cable not provided B i o e =t
: provide Cale [ <
Ethemet

Cat5 Ethen{ét _
EN4093 switch in /O bay 1
Chassis 1 Y
/o Ejﬂ chozz switch
2l FC3171 switch

Use odd-numbered ports
for modules in VO bays 1and 3

See ["Symbols, feature codes, and descriptions” on page 84| for the key to the
symbols used in the illustrations.

88 IBM PureFlex System: Supplemental Installation Information



= (vza-g6v2)

........uan_n_

(982€)d4S 04998 X 2-
_.=-40 0LEG)dIS 24998 X 2-

Cr
g feq ! Youms LLLEDS

¢ keq [ZEBEISEI0] wouws 121604

89

Appendix B. Cabling diagrams

Express multi-chassis with V7000 storage systems
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Standard configurations

This section provides illustrations of the Standard configurations.

Standard configuration with V7000 storage nodes

Customer or manufacturing

Cable not provided

Cat5

[
Ethetijet-.-_J ----- L 1 L | l

1] 2] 3] 4] 5] 6] 7] 8 9] 1911] 12|

EN4093 switch in /O bay 1

Chassis 1

FC Mezz 2
1[2]3]4
|

FC5022 switch
FC3171 switch

See [“Symbols, feature codes, and descriptions” on page 84| for the key to the
symbols used in the illustrations.
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Standard configuration with V7000 storage systems

Expansion Rules (7893):
-4XBGLEC SFP (5370)

' l 4XCables (5305)

/O FC5022 switch | 01|29 /0
bay 3 FC3171 switch | 0 [15 | bav4  eowisimna
ports for modules in
Use odd-numbered ? “ UObays2and4
mmsn Expansion Rules (7893):
4XBGbHFC SFP (3286)

4XCables (5305)

2 X fiber(5305)

o= = = Selectable,

_ . ==Expansion Rules

Cats /
Ethemet |
) EN4093 switch in 1/O bay 1
Chassis 1
/0 /O
bay 3 bay 4
FC5022 switch
FC3171 switch

See [“Symbols, feature codes, and descriptions” on page 84| for the key to the
symbols used in the illustrations.
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Standard multi-chassis with V7000 storage systems
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symbols used in the illustrations.
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Enterprise configurations

This section provides illustrations of the Enterprise configurations.

Enterprise configuration with V7000 storage nodes
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See [“Symbols, feature codes, and descriptions” on page 84| for the key to the
symbols used in the illustrations.

Appendix B. Cabling diagrams 93



Enterprise configuration with V7000 storage systems
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See [“Symbols, feature codes, and descriptions” on page 84| for the key to the
symbols used in the illustrations.

94  IBM PureFlex System: Supplemental Installation Information



:2_..5 _.E.mou_
HOEIBE] 0| uonms zz0s04 B

| sisseyo

+Aeq o/ Ul
OUMS E60FNI

PR

lawaylg

(yg03) oo o7 SIED
ova [

" (Bzaald1so
0} 4450

"¢¢r_m,/ |

d48 399 04 PR e d45 399 01

Jawosng

¥Za-86vZ)2-HOL N

Enterprise configuration with V7000 storage nodes and 4S

Power compute nodes

95

Appendix B. Cabling diagrams

See [“Symbols, feature codes, and descriptions” on page 84| for the key to the

symbols used in the illustrations.



Enterprise configuration with V7000 storage systems and 4S
Power compute nodes
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See [“Symbols, feature codes, and descriptions” on page 84 for the key to the
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See [‘Symbols, feature codes, and descriptions” on page 84 for the key to the

symbols used in the illustrations.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product, and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies.

A current list of IBM trademarks is available on the web at “Copyright and
trademark information” at |http://www.ibm.com/legal/copytrade.shtml] .
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Adobe and PostScript are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States and/or other countries.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc., in
the United States, other countries, or both and is used under license therefrom.

Intel, Intel Xeon, Itanium, and Pentium are trademarks or registered trademarks of
Intel Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Important notes
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Processor speed indicates the internal clock speed of the microprocessor; other
factors also affect application performance.

CD or DVD drive speed is the variable read rate. Actual speeds vary and are often
less than the possible maximum.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for 1024 bytes, MB stands for 1,048,576 bytes, and GB stands for
1,073,741,824 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1,000,000 bytes, and GB stands for 1,000,000,000 bytes. Total user-accessible
capacity can vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the
largest currently supported drives that are available from IBM.

Maximum memory might require replacement of the standard memory with an
optional memory module.

Each solid-state memory cell has an intrinsic, finite number of write cycles that the
cell can incur. Therefore, a solid-state device has a maximum number of write
cycles that it can be subjected to, expressed as “total bytes written” (TBW). A
device that has exceeded this limit might fail to respond to system-generated
commands or might be incapable of being written to. IBM is not responsible for
replacement of a device that has exceeded its maximum guaranteed number of
program/erase cycles, as documented in the Official Published Specifications for
the device.

IBM PureFlex System: Supplemental Installation Information



IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software might differ from its retail version (if available) and might not
include user manuals or all program functionality.

Particulate contamination

Attention: Airborne particulates (including metal flakes or particles) and reactive
gases acting alone or in combination with other environmental factors such as
humidity or temperature might pose a risk to the device that is described in this
document.

Risks that are posed by the presence of excessive particulate levels or
concentrations of harmful gases include damage that might cause the device to
malfunction or cease functioning altogether. This specification sets forth limits for
particulates and gases that are intended to avoid such damage. The limits must not
be viewed or used as definitive limits, because numerous other factors, such as
temperature or moisture content of the air, can influence the impact of particulates
or environmental corrosives and gaseous contaminant transfer. In the absence of
specific limits that are set forth in this document, you must implement practices
that maintain particulate and gas levels that are consistent with the protection of
human health and safety. If IBM determines that the levels of particulates or gases
in your environment have caused damage to the device, IBM may condition
provision of repair or replacement of devices or parts on implementation of
appropriate remedial measures to mitigate such environmental contamination.
Implementation of such remedial measures is a customer responsibility.

Table 3. Limits for particulates and gases

Contaminant Limits

Particulate * The room air must be continuously filtered with 40% atmospheric

dust spot efficiency (MERV 9) according to ASHRAE Standard 52.2'.

* Air that enters a data center must be filtered to 99.97% efficiency or
greater, using high-efficiency particulate air (HEPA) filters that meet
MIL-STD-282.

* The deliquescent relative humidity of the particulate contamination
must be more than 60%?>.

¢ The room must be free of conductive contamination such as zinc
whiskers.

Gaseous « Copper: Class G1 as per ANSI/ISA 71.04-1985°
+ Silver: Corrosion rate of less than 300 A in 30 days

1. ASHRAE 52.2-2008 - Method of Testing General Ventilation Air-Cleaning Devices for
Removal Efficiency by Particle Size. Atlanta: American Society of Heating, Refrigerating
and Air-Conditioning Engineers, Inc.

2. The deliquescent relative humidity of particulate contamination is the relative humidity
at which the dust absorbs enough water to become wet and promote ionic conduction.

3. ANSI/ISA-71.04-1985. Environmental conditions for process measurement and control
systems: Airborne contaminants. Instrument Society of America, Research Triangle Park,
North Carolina, U.S.A.
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Telecommunication regulatory statement

This product may not be certified in your country for connection by any means
whatsoever to interfaces of public telecommunications networks. Further
certification may be required by law prior to making any such connection. Contact
an IBM representative or reseller for any questions.
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